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1 Preface 

Intella is designed to be an email investigation and e-discovery tool. It is 

ideally suited for use by enterprise, law enforcement, and regulatory 

agencies in civil, criminal, or policy-related investigations. Intella is an 

excellent tool to prepare electronically stored information for discovery. 

Intella’s powerful indexing search engine and its unique visual presentation 

will let you quickly and easily search and review email and electronically 

stored information to find critical evidence and visualize relevant 

relationships. 

With Intella, you can...  

 Gain deeper insight through visualization 

 Search email, attachments, archives, headers, and metadata 

 Drill deeply using Intella’s unique facets 

 Group and trace email conversations  

 Preview, cull, and deduplicate email and data 

 Export results in a variety of formats for reporting, follow-up 

investigation, e-discovery, or later use 
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1.1 Training 

This manual outlines the features incorporated in the Intella products. Its 

focus is to explain the rudimentary functions of each feature in Intella. It 

should not be seen as explaining how to manage data or cases.  

While Intella is an easy and intuitive software package to use in the fields of 

forensic search, data analysis and eDiscovery, the user is required to have a 

firm grasp of how Intella treats and manages certain information/data 

types as applicable to these fields.  

As with any software, the user must understand issues that may arise while 

using Intella, particularly in the following areas: 

 Different data types 

 Emails and attachments (parent-child relationships) 

 Search parameters 

 Date structures 

 Inclusions and exclusions 

 Chain of custody 

 Legal issues  

This critical to being able to get the most out of Intella and undertake your 

investigation free from mistakes.  This manual cannot and does not offer 

this information. We do however offer training that will help the user to 

have a better understanding of these issues.  

We highly recommend that the user takes advantage of this training on the 

correct use of Intella. This can be critical for any matter where the user will 

rely upon the results produced in Intella as part of an action or 

investigation. Failure to undertake adequate training may cause unreliable 

results. 

Please contact us for additional information at training@vound-

software.com or visit us at http://www.vound-

software.com/information/training. 
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1.2 Document conventions 

The following section introduces you to conventions used throughout the 

Intella documentation. 

Menu Functions 

For functions that can be reached through menus, the different menu levels 

are illustrated as follows:   

Menu > Menu entry 

Important Entries 

Some text will be shown as follows: 

Important: Important information on Intella. 

These entries discuss a key concept or technical information that should, or 

must, be followed or taken into account. Please pay special attention to 

these entries. 

Notes 

Some sections provide additional information that will assist your use of 

Intella. These are displayed as shown below: 

Note: Information on function or parameter. 

Keyboard Shortcuts 

Some Intella functions can be activated or accessed through keyboard 

shortcuts. They are shown as follows:  

CTRL+E 

Tips 

A number of shortcuts, alternative methods, or general working tips are 

included throughout the documentation. These may help your workflow, or 
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provide additional information on other uses of functions. Tips are shown 

as below: 

Tip: Information on Intella. 

Folder and file names 

Folder and file names are shown as below: 

C:\Program Files\Vound\Intella\ 
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2 An introduction to 

Intella 

Intella is an instrument for data and email investigation and eDiscovery. It 

helps you search and explore information stored on your computer, 

network disks, in email boxes and PST, OST and NSF files. Intella is being 

used by Law Enforcement, Legal and regulatory bodies to do all of the 

above. 

Intella indexes all places where you expect valuable information and 

provides powerful means for retrieving that information. The important 

advantage over similar tools is that Intella presents the search results using 

facets and Cluster Maps. Facets allow you to find items based on more than 

just keywords and the visualization provided by the Cluster Maps allows 

you to see how files and emails are related to your query. 

The birds-eye view helps you gain insight in information that is available on 

combinations of keywords. In each step of your search it shows the number 

of emails or files that match your search (and of course a link to the e-mails 

and files themselves) so that you can effectively zoom in to find what you 

are looking for. 

Setting up Intella on your computer takes little time. Install the software, 

define the sources to search and explore and let Intella index the sources. 

Searching with Intella is also easy. Start as if you are using a familiar search 

engine by entering a search term, or choose any value from the information 

facets. Let Intella help you to refine your question with a list of suggested 

refinements. Use Cluster Maps to get a comprehensive overview of the 

available information. 
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2.1 Key benefits 

 Visualization of search results provides you with deeper insight. See 

how files, emails and cellphone items relate to parts of your query. 

 Facets, like Type, Date, and Language, help you to drill down to the 

wanted information and to focus on the information you need. 

 Search email attachments and archives such as zip files. 

 Searching is simple and requires very little training. 

 Export the search results for later use and for creation of reports. 

2.2 Intella editions 

Intella comes in seven different product editions. The table below shows the 

most important features of these editions. 

 10 

GB 

100 

GB 

250 

GB 

Professional Viewer TEAM 

Manager 

TEAM 

Reviewer 

Preparation 

   Case size limit 10 GB 100 GB 250 GB none none none none 

   Create new cases ● ● ● ●  ●  

   Index evidence files ● ● ● ●  ●  

Investigation 

   Search, filter & review ● ● ● ● ● ● ● 

   Preview items ● ● ● ● ● ● ● 

   Flag & tag items ● ● ● ● ● ● ● 

   Export items ● ● ● ● ● ● ● 

Cooperation 

   Export Cases ● ● ● ●  ● ● 

   Import Cases ● ● ● ● ● ● ● 

   Share Cases      ●  

   Connect to Shared Cases      ● ● 

   Export Work Reports      ● ● 

   Import Work Reports      ●  
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2.3 Supported file formats 

Intella can extract contents and metadata of the following file formats: 

 Mail formats: 

o Microsoft Outlook PST/OST 

o Microsoft Outlook Express DBX, MBX 

o Lotus Notes NSF 

o Mbox (e.g. Thunderbird, Foxmail) 

o Saved emails (.eml, .msg) 

o Apple Mail (.emlx) 

 Cellphone extraction formats: 

o UFED XML export 

o XRY XML export 

o Oxygen XML export 

 Document formats: 

o MS Office: Word, Excel, PowerPoint, Visio, Publisher, 

both old (e.g., .doc) and new (.docx) formats 

o OpenOffice: both OpenDocument and legacy 

OpenOffice/StarOffice formats 

o Hangul word processor (.hwp files) 

o Corel Office: WordPerfect, Quattro, Presentations 

o MS Works 

o Plain text 

o HTML 

o RTF 

o PDF 

 Archives: 

o Zip 

o Gzip 

o Bzip2 

o Tar 

o Rar 
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 Miscellaneous formats: 

o iCal 

o vCard 

o XML 

2.4 Supported sources 

 Folder 

Files on local and network file systems can be indexed by Intella. 

Please check the list of supported file formats. 

 

 Microsoft Outlook file (PST, OST) 

Emails and attachments in the email archive file of Microsoft 

Outlook can be indexed by Intella. 

Versions: 97, 98, 2000, 2002, 2003, 2007 and 2010 

 

 Microsoft Outlook Express file (DBX, MBX) 

Intella will index emails and attachments stored in a Microsoft 

Outlook Express DBX  and MBX files. 

Versions: 4, 5 and 6 

 

 Lotus Notes NSF file 

Intella will index email and attachments in an email archive file of 

IBM Lotus Notes. 

Versions: IBM Lotus Notes 8.5 needs to be installed on the 

computer that runs Intella in order to process Lotus Notes NSF 

files. Intella supports all NSF files that can be processed by Lotus 

Notes version 8.5, or that can be converted to a NSF file that Lotus 

Notes 8.5 can process. 

 

 Mbox file 

Intella will index email and attachments stored in Mbox files. 

Versions: We tested Intella on several email programs that use 

Mbox files with good results, e.g. Thunderbird and Foxmail. 
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 IMAP account 

Intella is able to access an email accounts on a IMAP email server 

and index emails and attachments. 

Versions: Intella was tested on several IMAP servers with good 

results. However, we cannot guarantee that Intella is able to create 

IMAP account sources for every IMAP email server. 

 

 Cellphone XML report(s) 

Intella can index information that has been extracted from 

cellphones with Cellebrite’s UFED devices, Micro Systemation’s 

XRY and Oxygen. To do so, the native file formats need to be 

exported to XML, which can then be added to an Intella case. See 

the documentation of the respective tool for instructions on how to 

export to XML. 

2.5 Supported platforms 

Intella is currently only available for Windows 2000, Windows XP, 

Windows Vista, and Windows 7. 

Note that Intella is not supported on Windows 2008. 

For detailed instructions about installation and running Intella, please read 

section 4: Installation and configuration. 

2.6 Version history 

2.6.1 Version 1.6.2 

Highlights: 

 Improved the reporting of indexing errors. 

 Various performance and stability improvements. 

 An experimental 64-bit version is available on request. This version 

makes better use of the resources that high-end machines have to 

offer, such as multiple cores and large amounts of memory. 

General: 
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 Several stability improvements for locally opened and shared cases. 

 Various improvements to logging, reducing the amount of 

irrelevant and innocent error messages. 

 Fixed an issue with Intella not exiting properly under certain 

circumstances. 

Case Manager: 

 Fixed an issue with the case conversion message on 1.5.x cases 

overlapping with the case’s description. 

Indexing: 

 The Sources menu has been extended with an Exceptions Report 

menu item for producing a report in CSV format of all items that 

had issues during indexing. Each problematic item is reported 

together with an error code, detailed error message and 

information on the item’s location. Issues can range from minor 

metadata parsing issues (e.g. a syntactically incorrect date field) to 

encrypted or corrupt items. 

 Various improvements to the indexing of Oxygen cellphone dumps. 

 Fixed an issue with the indexing statistics shown in the user 

interface counting certain items twice. The statistics reported by 

the facets were already accurate. 

Searching: 

 The Email Address facet now lowercases the host part (everything 

after the ‘@’ sign). 

 The table columns and column groups shown in the Details table’s 

column chooser now have a fixed order. 

Results: 

 The default icons in the Thumbnails view have been improved. The 

new icons stand out more from the already loaded thumbnails. Also 

a different icon is shown when the image fails to load properly, e.g. 

when the image file is broken. 
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 The thumbnail view no longer showed the number of embedded 

items found in the selected results. This functionality has been 

restored. 

Previewing: 

 Fixed several issues with Open in Application failing to open the 

item in its native application. 

 Open Containing Folder was sometimes incorrectly enabled in 

shared cases. 

Exporting: 

 Added an option to export the social graph (“who communicates 

with whom”) of a selected set of emails to a data file. The graph can 

be stored in CSV, GML or GraphML format. A variety of social 

network analysis tools exist that can consume these formats. 

 Documents in landscape mode were added to exported PDFs in 

portrait mode. This has been resolved; the produced PDF now uses 

the correct orientation for every single page in the original 

document. 

 The item’s ID is now included in exported PDFs. 

 The i2 Analyst’s Notebook & iBase export now also contain 

cellphone-specific metadata such as phone numbers and call 

duration. 

TEAM: 

 Several server-side and client-side performance improvements 

when accessing shared cases. 

 Fixed an issue with the last used port and passphrase not being 

remembered for shared cases. 

 Improved memory usage of work report exporting. 

Upgrade Notes: 

 In principle, Intella 1.6.2 can open cases made with Intella 1.6 and 

1.6.1 and search and export items from them, without any need for 

case conversion or reindexing. For 1.6.1 cases reindexing is only 
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recommended when the original case had indexing issues for which 

Intella 1.6.2 contains a fix. For 1.6 cases we do recommend that you 

reindex if you have not already done so with Intella 1.6.1, because of 

memory usage improvements that require one of the databases to 

be rebuild. Please back-up your cases before attempting to reindex 

them. 

 Cases made with 1.5.x versions are shown in the Case Manager as 

needing conversion before they can be opened. 

 Cases made with older versions are not supported. 

2.6.2 Version 1.6.1 

Highlights: 

 This release is backwards compatibility with cases made with 

Intella 1.5.x. 

 The Dongle Manager has been extended with proxy support. 

 Added “Smart Search” functionality. 

 Added a case backup feature that is optionally run when a case is 

closed. 

General: 

 Resolved an issue with Intella failing to render its UI properly when 

viewed through a remote desktop connection (RDP). 

 Various improvements to reduce the potential negative impact of 

virus scanners on Intella’s database files. 

 Added links in the Help menu to the new Dongle Manager and the 

online Intella forum. 

 A warning is now shown when opening a case whose case folder is 

not writable. 

Translations: 

 The first time when a user starts Intella, a language chooser may 

pop up (depending on the Windows platform language), asking the 

user what display language to use. 
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 A message is displayed when an improved translation pack is found 

online for the currently used Intella version. This translation pack 

can be installed through the Preferences window. 

License Management: 

 The Dongle Manager has been extended with support for proxies. 

This facilitates the use of this utility in most corporate 

environments. 

Case Management: 

 Cases made with Intella 1.5.x can be opened in Intella 1.6.1. Intella 

1.6 did not have this ability and would show these cases as disabled. 

Before a 1.5.x case can be used in Intella 1.6.1, the case needs to be 

converted first. This process creates a duplicate of the case that is 

restructured so that it can be opened in 1.6.1. This way the old case 

is not altered in any way and can still be used by the 1.5.x versions. 

During the conversion process the data will be reindexed to benefit 

from all improvements that 1.6 and 1.6.1 have to offer. The time 

needed for this conversion is roughly the same as the amount of 

time needed for the original indexing. 

 When closing a case, Intella offers the user to back up the case to 

the configured backup folder. This backup folder can be set in the 

Preferences. We recommend changing the default backup location 

to a folder on a separate physical disk. 

 The Add Case dialog has been extended with a help dialog offering 

information on the best practices regarding hardware setup, 

especially for optimizing indexing performance. 

Indexing: 

 Added preliminary support for indexing Oxygen cell phone dumps 

(version 4.x). 

 Various improvements in indexing of XRY cell phone dumps. 

 Improved the extraction of email senders and receivers of mails in 

a PST file, when the information in that PST file is inconsistent. 
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 A warning is now shown before indexing when the remaining free 

space of the disk holding the case folder is less than twice the size of 

the evidence data. 

 M4R/M4A ringtone files are now detected and typed accordingly. 

 Resolved an issue with incorrect Location values. 

 The method for caching extracted items has been improved, 

providing better stability on very large cases. 

 Tokenization improvements that improve search results on 

complex file names. 

 Resolved an issue with indexing folders whose name contain an 

exclamation mark. 

 Improved various logging messages, replacing long error stack 

traces with shorter and more meaningful errors and warnings. 

Searching: 

 Speed improvements in the population of the Email Address and 

Author facets. 

 “Smart Search” replaces the old near-duplicate search with an 

alternative that offers configurable settings, live result previews 

and explainable results. 

 The node representing the “Others” branch in the Type facet can 

now also be used as a search criterion, allowing the user to gather 

all files with unusual types at once. 

Results: 

 When previewing emails from PST files, the Raw Data tab in the 

Previewer shows the raw output of what has been extracted from 

the PST file, including lots of PST-specific fields. This information 

is also indexed and made searchable with keyword search. 

 Usability improvements in the table sorting editor. 

Tagging: 

 In some situations newly defined tags were not added to the Quick 

Tags buttons in the Previewer. This has been fixed. 
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 Tag descriptions (the optional field for documenting e.g. a tag’s 

intended purpose and usage) can now be changed. 

Exporting: 

 When exporting the list of values of a given facet, the resulting CSV 

file now contains at least three rows: (1) facet value, (2) number of 

matching items in the entire case and (3) number of matching 

items in the current result set. This makes it unnecessary to do any 

searching before the overall counts in the case can be reported. 

 Added options for controlling the contents of PDFs and TIFFs that 

are produced as part of a load file. 

 The item IDs (numbers) introduced in Intella 1.6 are now used in 

export reports. They replace the URIs previously displayed here. 

 Improved the reporting of export errors on items that are 

inherently not exportable, e.g. files embedded in encrypted ZIP 

files. 

 Resolved an issue with the contents of PDF documents not being 

processed correctly when exporting to PDF. This only affected PDF 

documents that Intella classifies as Empty Document. 

 Resolved an issue with messages attached to MSG and EML mails 

failing to export. 

 Resolved an issue with items not opening properly after importing 

an ICF file. 

 Resolved an issue with reviewer comments not being added to 

printed items. 

TEAM: 

 Improved the usability of the case sharing setup dialog. 

 Improved the usability of the remote case connection dialog. 

 Added a version check when the Reviewer opens a connection to a 

shared case, so that the connection is only established when client 

and server use compatible protocols. 

 Various improvements to the user event log in shared cases. 

Upgrade Notes: 
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 Intella 1.6.1 can open a case made with Intella 1.6 and search and 

export items from it, without any need for case conversion or 

reindexing. Reindexing is only necessary when one wants or needs 

to make use of the indexing improvements or the new Raw Data tab 

in the Previewer. 

 Cases made with 1.5.x versions are shown in the Case Manager as 

needing conversion before they can be opened. 

 Cases made with older versions are not supported. 

2.6.3 Version 1.6.0 

Highlights: 

 Share cases over a network with Intella TEAM Manager. 

 Index cell phone dumps made with Cellebrite and XRY. This allows 

for mixing call and messaging data, emails and documents in a 

single case, for uniform reviewing and exporting. 

 The new Dongle Manager lets dongle owners inspect their current 

licenses and fetch and apply updates from the Vound server with a 

single click. 

 Case folders are now completely self-contained, meaning that items 

can be exported and previewed without access to the original 

evidence files. This makes these operations faster and more 

reliable. 

 A translation framework allows Intella’s user interface to be 

translated to other languages. Various translations are being 

worked on. 

General: 

 This release has the ability to switch between different languages, 

based on the language profiles that are available in the languages 

subfolder in Intella’s installation folder. We are working with 

several resellers on getting Intella translated to other languages. 

 Contacts found in e.g. PST files, cell phones or as vCard files are 

now handled in a better way: they are displayed more naturally and 
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with more detail in the Previewer, are exported as vCards when 

using Original Format, and can now also be exported to a PST. 

 All case-specific preferences like tagging settings, chosen table 

columns, etc., are now stored in a single, simple to understand text 

file, stored in the case folder as prefs\case.prefs. This allows for 

manual editing of the file as well as copying a template file to new 

cases. 

 Several stability and performance improvements. 

 Rearranged some options in the Preferences dialog. 

 Resolved an issue with the application not exiting properly, locking 

access to the case until the machine was rebooted. 

License Management: 

 Intella 1.6 starts bundling a new Dongle Manager. This application 

shows all connected Vound dongles and displays the licenses that 

they hold. When the PC running the Dongle Manager is connected 

to the Internet, the Dongle Manager can on the user’s request 

contact the Vound license server to see if there are any updates 

available for a dongle. These updates are then downloaded and 

applied to the dongle fully automatically. 

 Resolved an issue with Intella not starting when using a Remote 

Desktop (RDP) session, even though a dongle with a valid license 

was present. This fix only applies to Intella 1.6 and newer. For 

Intella 1.5.x the patched dongle driver that we distribute remains 

necessary. 

Case Management: 

 Various buttons in the Case Manager have been grouped behind a 

single “Add…” button, which opens a new dialog with all case 

adding options and explanations. 

 The Case Manager table has been replaced with a list that shows 

the details of the currently selected case only. This makes the 

information a lot easier to oversee, allows for better display of long 

textual values and was necessary to accommodate the new remote 

case functionality. 
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 When opening the Case Manager, its last position, window size and 

last used case is restored. 

 The Intella version used to create a case is now shown. 

 The Case Manager now has its own folder with log files, 

independent of any case-specific log files. Any issues related to the 

creation, exporting or importing of cases will now be logged in 

these log files. 

 When removing a case in the Case Manager, the user now needs to 

mark a checkbox to explicitly trigger (and approve of) the removal 

of the associated case folder from the file system. 

Indexing: 

 Cell phone data extracted with Cellebrite and XRY can now be 

added to a case, making artifacts like phone calls, text messages, 

emails and images extracted from cell phones searchable. To use 

this functionality, export out the contents of these dumps as an 

XML report and add those as a Folder or Cell Phone source to the 

Intella case. A case can hold multiple cell phone extracts, allowing 

one to investigate any number of phones at once, even mixing data 

obtained with both Cellebrite and XRY in the same case. 

 All extracted items (emails, attachments, embedded images, etc.) 

are now stored inside the case folder. This ensures that results can 

always be exported when the user upgrades to a newer version and 

does not reindex. Also this makes previewing and exporting faster 

and more reliable. 

 As all extracted items are now stored in the case folder, there is no 

need to access the original evidence files after indexing anymore, 

except when the user wants to reindex the case. Consequently, all 

functionalities related to setting evidence paths have been 

removed. 

 The Add Source wizard has been simplified by the removal of the 

parameters that control whether MD5 hashes, message hashes, 

duplicate counts and near-duplicate hashes are calculated, what the 

maximum size of the indexed items is and whether deleted items 

should be recovered from PST files. These options are typically all 
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left on and generally did little for speeding up indexing when 

turned off. The “create sources for mail files” option has been 

renamed to “index mail archives”. 

 Greatly improved the indexing speed of IMAP mail folders. 

 Resolved an issue with a case not accepting any new sources after 

an IMAP source had been added to it. 

 Improved the error that is shown when the user tries to index a 

write-protected NSF file. 

 When validation of Lotus Notes has failed, a warning is now also 

displayed in the folder selection screen when defining a new Folder 

source. 

 Improved the parsing of email senders and receivers to handle 

more standard-violating formats that we have encountered in the 

field. 

 Improved text and image extraction on MS Office and PDF 

documents. 

Searching: 

 Added a Phone Number facet. This facet gathers all phone numbers 

from cell phones as well as any phone numbers found in vCard files 

and PST contacts. 

 The Date facet has been reorganized: the Sent and Received fields 

are now at the top of the list and have been made the default 

selected fields. A “Called” field has been added for searching phone 

calls that were made within a certain date interval. 

 The Type facet has been extended with several new document 

types, e.g. RSS feeds, faxes, voice mails, meeting requests, 

appointments, etc. The Messaging & Scheduling category has been 

split up in a Communications category and a separate Scheduling 

category. 

 The Keyword Search Quick Reference has been improved to cover 

wildcards and proximity searching in more detail. 

 Improved the Saved Searches facet to distinguish the local user’s 

saved searches from those made by others working on the same 

case. 
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 Resolved an issue with saved searches not storing a search properly 

when a keyword search started with a wildcard. 

Tagging: 

 Usability improvements in the tag rename dialog. 

Results: 

 Since Intella 1.5 folders can be returned as search results. Folders 

could not yet be tagged in the Tree tab nor where they hyperlinked. 

This has been fixed. 

 Every item in the case now has a unique item ID (a positive 

number) associated with it. These numbers are shown in the 

Previewer’s window title bar, the Item ID column in the Details 

table, and in any user events visible to the TEAM Managers and 

TEAM Reviewers when connected to a shared case. One can 

directly open a numbered item by using the “Preview Item…” 

option in the View menu. 

 When the user moves from item to item with the Previewer’s Next 

and Previous buttons, the currently selected tab will now stay 

selected. 

 Resolved an issue with the Tree tab in the Previewer not showing 

the children of folders and certain other nodes. 

 Resolved an issue with folder names not being shown in all 

appropriate places. 

 The Name column has been renamed to File Name to make it less 

ambiguous. 

Exporting: 

 Contacts can now be exported to a PST file. 

 The content of the various load file exports has been improved 

based on customer feedback. 

 Renamed the “Terms…” option in the Export menu to “Words…” to 

make it consistent with the Words tab in the Previewer. 

 The wizard through which the Cluster Map graph could be stored 

has been replaced by a much simpler file chooser. 
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 Minor usability improvements in the export of the Details table to a 

CSV file. 

TEAM: 

 When using a TEAM Manager license, the Case Manager now 

shows a Share button. Through this button one can provide access 

to the case over the network to other users that have a TEAM 

Manager or TEAM Reviewer license. This eliminates the need to 

share case files, evidence files and work reports between the 

investigators working on the same case. Remote case access is 

password-protected. 

Upgrade Notes: 

 Cases made with older Intella versions cannot be opened in Intella 

1.6. In the upcoming 1.6.1 release an upgrade function will be 

included for upgrading cases made with a 1.5.x version to the 1.6 

format. 

2.6.4 Version 1.5.4 

General: 

 User interface improvements that prevent it from freezing or 

experience similar problems on machines with slow disks or 

network connections. 

 Resolved an installer issue that broke indexing and exporting from 

NSF sources on some PCs. 

Indexing: 

 Improved indexing of plain text-like files like source code, 

shell/batch scripts, etc. 

Searching: 

 All facets now show the total amount of items in the entire case for 

each value. Some facets were already showing this information; this 

has now been extended to all facets. 
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 Resolved an issue with the Type facet not updating immediately 

when a new source has been added. 

 Resolved an issue with the last used searches not restoring fully 

when the “Restore the queries that were shown last” preference 

option is switched on. 

 The Tags facet no longer shows the tree expansion toggle for nodes 

without sub-nodes. 

 Improved the way the Date facet searches on a date range, by 

including the entire start and end day, rather than taking the 

current time of the day into account. 

Results: 

 Resolved an issue with the contents of the Details table and the 

selection in the Cluster Map changing when the Previewer was 

opened on one of those results. This happened under specific 

circumstances only. It affected reviewing of a list of results using 

the Previewer’s Next and Previous button. 

 The List view (the Details view mode that resembles a search 

engine result listing) listed the source of each result using its 

internal identifier. This has been changed to show the source name 

instead, consistent with the Source column in the Table view. 

 Improved the indication of the found keywords in the Previewer 

when the shown text is initially truncated due to its length. 

Exporting: 

 Resolved an issue with the CSV export of the facet values failing, 

depending on which facet value was right-clicked to initiate the 

export. 

 Improved the progress notification dialog when exporting an ICF 

file: there was a delay between the progress dialog disappearing 

and the end dialog appearing, which could lead one to mistakenly 

believe that exporting had already completed. 

 The audit trail used to list the identifiers of all selected items when 

a facet value was selected. This has been changed to only list the 
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amount of selected items, to prevent the audit trail file from 

growing to impractical sizes. 

 Resolved an issue with CSV exporting unnecessarily validating 

some sources before exporting, delaying the export a bit. 

TEAM: 

 Resolved an issue with the Features facet not updating fully when 

an imported work report was rolled back. 

Upgrade Notes: 

 Cases made with 1.5.3 that did not have any indexing issues do not 

require to be reindexed when the case is opened with 1.5.4. 

 Cases made with 1.5, 1.5.1 or 1.5.2 can be opened and used in 1.5.4 

without reindexing, but with two limitations: 

o Indexing improvements that were present in 1.5.3 and 

older will only be effective after reindexing. See the release 

notes of these previous versions for full details. 

o Some items may be problematic to export without 

reindexing the case first. 

2.6.5 Version 1.5.3 

General: 

 Added a date format setting in the Preferences. With this setting 

users can adjust the way dates are displayed to their preferred 

regional style. This controls both the display style used in e.g. the 

Details table and the Previewer as well as the format in which these 

dates are entered in the Date facet. 

 Resolved an issue with the main process not exiting properly when 

the user closes Intella. 

 Expert option: the maximum Java heap size of the main process 

and child processes can now be adjusted through the Intella.l4j.ini 

file that is located next to the Intella.exe file. This can be used to 

remedy certain memory issues. 

Case Manager: 
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 Relaxed version check: 1.5.3 will be able to open cases made with 

future 1.5.x versions. 

 Intella’s File menu has been extended with a “Close case” option, 

which closes the current case and returns to the Case Manager. 

 Cases made with 1.4.x or older can no longer be imported. 

Previously you were still able to import them even though you 

could not open them afterwards. 

Indexing: 

 Added detection of emails encrypted with Outlook Information 

Rights Management (IRM). 

 Added detection of MS Exchange database files (.edb files). 

 Reduced the dependency on file extensions when identifying a file’s 

type. For example, previously MS Office files could be detected 

based on contents but a correct file extension was still necessary for 

distinguishing between Word, Excel, etc. Here, type identification 

is now based on contents alone. 

 Many minor improvements in text, metadata and image extraction 

quality. 

 Reduced memory usage of indexing. 

 Resolved an issue with mails sent from BlackBerry phones not 

being identified as emails. 

 Improved message hashing robustness, e.g. differences in 

whitespaces in the body or the headers will not result in a different 

message hash any longer. 

 Improved robustness of email body selection for PST, OST and 

MSG emails. The message bodies in these formats can be stored in 

plain text, HTML and/or RTF format, each of which can in theory 

be damaged independently of the others. Intella now uses the 

representation that shows the least signs of corruption. 

 When a mail source is defined directly in the Add Source wizard, 

rather than inferred during processing of a Folder source, the mail 

file will now have a Type and MD5 hash. Previously this was only 

the case when a Folder source was used. 
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Searching: 

 Added a Saved Searches facet: the current list of searches, includes 

and excludes can now be stored under a user-defined name. This 

list can be restored at a later time through a single click. Saved 

searches can be shared through export and import options that the 

facet offers, or as part of a work report. 

 Optimized the facet order: the most-used facets are now at the top 

of the list. 

 Improved accuracy of near-duplicate searching. 

 Resolved an issue that caused some queries not to be restored when 

the “Restore the queries that were shown last” option was switched 

on. 

 Resolved an issue with the Show Parents function not reporting all 

parents. 

Tagging: 

 Added an Undo Actions item in the File menu. This opens a 

window that lets you undo tags, flags and comments. This is 

particularly helpful when a tag has been used several times on lots 

of items and one of those times was a mistake. Removing these tags 

manually would otherwise be very time-consuming and error-

prone. 

 Resolved an issue with include and exclude searches not updating 

automatically when items are (un)tagged. 

Results: 

 Resolved an issue with the Details column not showing all senders 

and receivers of an email. Query results and the contents of the 

Previewer window were not affected by this. 

Load file exporting: 

 Intella 1.5.2 already added support for exporting Summation and 

Concordance load files. Version 1.5.3 extends this list of supported 

formats with Relativity and Ringtail. 

 Improved the design of the load file field chooser. 
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 Increased flexibility when configuring item numbering in a load 

file. 

 Added support for JPG and PNG as load file image formats. 

 Summation load files can now use a user-specified encoding. This 

enables the export of load files that should not use the local 

platform code page. 

 Improved the contents and layout of the load file images. 

Other exporting: 

 The entire contents of the Export window, including the 

configuration of the load file field chooser, can now be stored as a 

named template. 

 When exporting to Original Format or PDF, either the file 

name/subject or a consecutive number could be used as file name. 

Now these two options can be combined: a third option lets you use 

a consecutive number followed by the original file name or email 

subject. 

 All sources used in an export are now validated (checked for 

presence and accessibility) before exporting. This way the user is 

notified of common errors within minutes after clicking the Export 

button rather than hours or longer. 

 Added detection of 64-bit Outlook when exporting to a PST file. 

Only 32-bit Outlook is supported, 64-bit used to result in a non-

descriptive error message. 

 Reduced memory usage of exporting, fixing “out of memory” 

errors. 

 Improved rendering of links in generated PDFs: the links are now 

blue and underlined. 

TEAM: 

 When importing a case to a device that does not have enough free 

space left, the user can now enter a different path. Previously only 

an error was displayed. 

 Fixed failed import of cases on PCs that had no cases on them 

created before, or where the manually specified folder did not exist. 



Page 38| Intella™ User Manual | © 2012 Vound, LLC 

Upgrade Notes: 

 Version 1.5.3 can open and search cases made with older 1.5.x 

versions without reindexing. However, the changes listed below 

“Indexing” and some of the other changes will only be effective 

after reindexing the case. 

 Due to some necessary changes in processing, the message hashes 

will be different in a case made with or reindexed by 1.5.3. 

2.6.6 Version 1.5.2 

General: 

 This version introduces a new product type: Intella Professional. 

Intella Professional has no hardcoded limit on the allowed 

maximum case size. 

Indexing: 

 Resolved issues with indexing folders in NSF files whose names 

contain unusual characters. 

Searching: 

 Made MD5 list search work with more plain text file encodings. 

This fix results in MD5 lists that are exported by EnCase to work 

without modifications to the file encoding. 

To benefit from this improvement, currently added MD5 lists need 

to be re-added to the case. 

 Resolved a Cluster Map selection issue that was triggered by 

combining right-clicks with the Ctrl and Shift keys. 

Exporting: 

 Added support for exporting items as a Load File. This export is 

currently in the beta phase and may therefore change in future 

versions. Initially supported are Summation and Concordance. 

 Intella 1.5.2 makes the export to i2’s Analyst’s Notebook and iBase 

available to all license types. Introduced in Intella 1.5.1, this 
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functionality was originally only available to users of Intella TEAM 

Manager. 

 Automatic numbering of exported files is now available in all 

product types. 

 Minor improvements to logging, export reports and indexing of 

large XLSX files. 

TEAM: 

 Resolved an issue with work reports that failed to properly filter 

reviewer annotations by source. 

Upgrade Notes: 

 As part of its standard procedures, Intella will detect the version 

upgrade when you open a case made with 1.5 or 1.5.1 and suggest 

that you reindex the case. 

o Reindexing of a case made with 1.5.1 is only necessary for 

cases containing XLSX files that could not be indexed. 

When this is not the case, reindexing can safely be skipped. 

o Cases made with 1.5 will open with 1.5.2, but sorting of the 

Senders and Receivers columns may not work correctly 

until the case has been reindexed. 

 Cases that were made with versions older than 1.5 cannot be 

opened. 

2.6.7 Version 1.5.1 

Installer: 

 When installing on a Windows 2008 machine, the installer no 

longer blocks installation but instead warns the user that this is not 

an officially supported platform to run Intella on. 

Case Management: 

 Added a column in the case manager that shows the last version 

used to open a case. 

 Resolved rendering issues in the case table when a case is imported 

or renamed. 
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Indexing: 

 Improved the error messages shown when an NSF file is locked by 

another application or for some other reason appears to be 

inaccessible. 

 Removed the “Add…” button from the Source Editor. The only way 

to add a source is by using the “Add New…” option in the File menu 

or through the Ctrl-N shortcut. This allows for a more streamlined 

user experience, as the indexing process that typically follows after 

adding a source blocks the main window. 

Searching: 

 Resolved an issue with keyword lists that were not being stored, 

due to illegal characters or other technical reasons. 

Results: 

 Improved sorting performance in the Details table. Both single 

column sorting and multi-column sorting benefit from major 

improvements in this area. 

 The component that lets the user select the visible columns in the 

Details table has been redesigned to allow for the growing number 

of columns. The columns are now grouped into five meaningful 

categories. 

 The Details table can now be configured what to show in the 

Senders and Receivers columns: email addresses, contact names or 

both. 

 Right-clicking on a cluster in the Cluster Map now automatically 

selects that cluster when it is not part of the current selection. This 

prevents potential confusion on what the selected operation in the 

popup menu is going to work on. 

Exporting: 

 Added a fourth export type: iBase & Analyst’s Notebook. This 

exports out information in a format that can be imported into these 

applications with the use of the provided templates and import 

specifications. 
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 Added a UTF Byte Order Mark to all generated CSV files. This 

improves how these files are displayed in Excel, especially when 

containing non-Latin characters. 

 Added a template facility to the table CSV export: a specific 

arrangement of columns can now be stored under a user-defined 

name. This facilitates optimizing frequent export tasks such as 

exporting MD5 and message hash lists. 

 Improved the performance of the first phase of exporting, where 

the items are sorted and prepared in other ways for exporting. 

 The “Export…” menu option in the table’s popup menu and other 

places is now explicitly disabled when you have selected a folder. 

 Resolved an issue with exporting items that have an exclamation 

mark in the file name, under some circumstances these files 

refused to export. 

 Improved the error messages shown during exporting that are due 

to NSF files being locked or that for some other reason are 

inaccessible. 

 Resolved an issue with exporting mails from Mbox files to a PST 

file when the Mbox file comes from a UNIX/Linux machine. The 

difference in the encoding of end-of-lines between these platforms 

corrupted the display of certain mails. 

TEAM: 

 Resolved an issue with work reports failing to import due to tag 

names that are already in use. This can happen when (1) a tag with 

that name is added to the master case after creation of the ICF file 

that the reviewer is using, or (2) when a work report imported 

earlier introduced a tag with the same name. Such tags can now be 

renamed or merged with an existing tag during importing. 

Upgrade Notes: 

 As part of its standard procedures, Intella will detect the version 

upgrade when you open a case made with 1.5 and suggest that you 

reindex the case. The case will work without reindexing, but sorting 

of the Senders and Receivers columns may not work correctly. 
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 Cases that were made with versions older than 1.5 and could not be 

opened with 1.5 (grayed out in the Case Manager) remain 

inaccessible with version 1.5.1. 

2.6.8 Version 1.5 

General: 

 Resolved an issue with Intella 1.4.3 failing to start on some PCs, 

exiting immediately with the message “Could not create Java 

virtual machine”. 

 Reduced memory usage of the application, allowing larger cases to 

be handled. 

 Performance improvements throughout the application, making 

especially search operations and listing of facet values faster. 

 Improved number formatting throughout the application. 

Indexing: 

 Improved the robustness of text, metadata and image extraction of 

files such as PDF, Word and ZIP files. 

 Improved the extraction of deeply nested items in MS Office files. 

 Improved indexing speed on PST and NSF files. A speed 

improvement of 10-50% can be expected on most PST and NSF 

files. 

 Reduced duplicate messages extracted from NSF files. 

 Added support for indexing Hangul word processor documents 

(HWP file format). 

 Indexing speed statistics are logged to a CSV file in the logs folder, 

to facilitate the analysis of indexing performance bottlenecks. 

 Improved the UI messages that are shown during (re)indexing. 

 Resolved an issue where certain characters in an NSF file name or 

characters in a folder name inside an NSF file resulted in the file 

not being indexed. 

 The folder tree in the Add Source wizard can now be refreshed to 

reflect changes in the file system. Right-click and choose Refresh, 

or move the wizard one step back and forth. 
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 Fixed missing message hashes in certain border cases, e.g. 

recovered mails. 

 Improved parsing and handling of email senders and receivers that 

do not comply with the email standards. 

 Improved error messages on files that are broken or otherwise 

impossible to index. 

 When adding a new Folder source while using a license with a case 

size limit, a folder size check is always performed, to see if the 

chosen folder is larger than the remaining allowed case size. This 

check now shows a progress screen and can be skipped. 

 All time-outs used during indexing can now be adapted if 

necessary. 

Searching: 

 Search performance has been greatly optimized through the use of 

a new, highly tuned database. Search results will now show almost 

instantly in the Cluster Map and Details views. 

 The Source and Location facets have been merged. PST files and 

other mail container files now show up as nodes in a single folder 

tree, rather than as independent roots. 

 Folders in the Location facet can now be searched with or without 

the inclusion of their subfolders.  

 Folders can now be returned as search results. 

 Improved the results of the Show Children operation on items 

containing folders, such as certain ZIP files. 

 The Date facet now offers a calendar component for choosing the 

start and/or end date. 

 Added categories in the Type facet for Contacts and Tasks extracted 

from PST files. 

Tagging: 

 Resolved an issue where the OK button in the Add dialog would not 

be enabled if any of the selected results already had the selected 

tag. 
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 Resolved an issue with the Remove Tags dialog showing tag counts 

that were too large. 

 Tags that are already applied to all selected items are now disabled 

in the Add Tags dialog. 

 Adding and removing tags has become faster. 

Results: 

 The Title/Subject column has been split into separate Title and 

Subject columns, as some document types support both fields. 

 The counts shown in the Duplicates column (formerly the Copies in 

Source column) now reflect the number of duplicates in the entire 

case, rather than the number of duplicates within the same source. 

 Resolved an issue with the deduplication function not removing all 

duplicates of an item. 

 Enforced consistency between the Type facet’s Images branch and 

the Thumbnail view: every item that is classified as an Image will 

now be displayed in the Thumbnail view, even when the Thumbnail 

view does not support that image format. In that case a generic icon 

is displayed. 

 Improved image-related operations such as the Thumbnail viewer 

and the export to PDF when image caching is switched off. 

Exporting: 

 All terms in the index can now be exported to a text file, e.g. for use 

in a password cracking tool. For each term the field name 

(corresponding with the options in the Search options panel) and 

document frequency is optionally listed. When these options are 

used, the result will be a comma-separate value file (CSV format), 

with each keyword described on a single line. 

 Additionally, the terms of a selected set of results can be exported. 

 Improved the folder layout of the generated folders to more closely 

reflect the location of an item in the original evidence file. 

 Resolved an issue where the generated PDF of a TIFF image would 

contain a barely readable image. The full resolution is now 

retained. 
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 The folder being exported to no longer has to be empty. A warning 

is now produced when the folder is not empty. Note that each 

export run will start new export reports, they are not merged. 

 Concatenated PDFs can optionally be split in chunks of a given size. 

This improves stability of the export process. 

 Fixes for various time-out issues. All time-outs used during 

exporting can now be adapted if necessary. 

Previewer: 

 Added a Words tab. This tab shows all terms in the full-text index 

that are associated with this result, ordered by field name. These 

fields correspond with the options in the Search options panel. The 

Words tab can be used to find out why certain queries won’t match 

a particular document. The terms can be exported to a CSV file, 

together with their field names and other statistics. 

 The tree structure shown in the Tree tab now fully corresponds 

with the tree structure shown in the Location facet. 

 Improved the accuracy of hit highlighting for phrase searches. 

 The Expand button in the Tree tab now has a corresponding Stop 

button, which lets you interrupt loading of the entire tree. The 

entire tree may be very large for file types like ZIP files. 

 Enabled previewing of CSV and TSV files in their original layout. 

 On small screens the default Previewer size will be reduced to fit on 

the screen. 

 Resolved various memory leaks. 

Case Management: 

 The Case Manager disables (grays out) cases made with Intella 

1.4.3 or older. Not only are the case data files incompatible with 

this release, opening them with Intella 1.5 might also damage these 

files. Please use Intella 1.4.3 to open these cases. 

 When opening a case, Intella would already check the presence of 

evidence files relevant for this case and give the user the 

opportunity to relocate the files, to work around changed folder 

names and drive letters. When relocating such a file, the file name 
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and size of the chosen file is now checked against the name and size 

that the file had during indexing.  A warning is displayed when 

these do not match. 

 Resolved an issue with cases failing to correctly export to an ICF 

file due to the presence of certain non-ASCII characters in evidence 

file names. 

 The audit trail now lists for each tagging action what tagging 

settings were used, i.e. what type of tagging inheritance was used 

(upwards/downwards/none) and whether automatic tagging of 

duplicates was used. 

 When removing a case, the Case Manager now shows an animated 

indicator during the entire operation. Before, it would freeze until 

deletion had completed. 

 Fixed an issue where exporting an ICF file failed due to lack of disk 

space, even though the free disk space was actually sufficient to 

hold the ICF file. 

 Made the Attach Evidence dialog able to handle multiple sources 

with the same file path. 

Licensing: 

 Intella is now distributed as a single installer that automatically 

runs as the product edition licensed to you (e.g. Intella Viewer, 

Intella TEAM Manager, etc.). When licenses can be found on the 

connected dongle(s) for multiple product editions, a window is 

opened that lets the user choose the desired license. 

 The trial license is now limited to indexing 10 GB of evidence files 

per case and can export maximally 1000 items at a time. 

 The HASP Admin Control Center sometimes used to show product 

numbers instead of product names in various overviews. This has 

been fixed; the product name should now always be shown. 

Upgrade notes: 

 Intella 1.5 is not backwards-compatible: cases made with Intella 

1.4.3 or older cannot be opened. This is because of the massive 

changes that were needed to improve search performance. 
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 Starting with version 1.5, sources can no longer be removed from a 

case, only added. 

 The installer now refuses to install on Windows 2008. This has 

always been an unsupported platform on which the correct 

execution of the application cannot be guaranteed. 

2.6.9 Version 1.4.3 

Case Manager: 

 The Case Manager now shows the full product name (including 

product edition) and the product version. 

 The Case Manager now shows whether a trial license is used or, 

when running on a dongle, what the ID of the dongle is. 

Indexing: 

 Various stability improvements, including processing of very large 

XLSX files. 

 Resolved an issue where words in DOCX files were concatenated in 

the extracted text. 

 Improved text extraction quality on XLSX files. 

 Resolved several text extraction issues with certain mails, including 

Chinese mails using GB2312 encoding. 

 Resolved an issue with encrypted ZIP files not being classified as 

encrypted. 

 Resolved an issue with incorrect dates in PST files. Before, a broken 

Date header could lead to an email not having a Sent date in the 

results list. Now, when a Date header is broken, the 

PR_CLIENT_SUBMIT_TIME field is used instead as the Sent 

value. 

 Resolved an issue with PST/OST files failing to index because of 

non-ASCII characters in the name of the PST/OST file. 

Searching: 

 Resolved an issue where the "Restore the queries that were shown 

last" option was set and tag queries failed to be restored. 
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 The keyword search history now looks up previous searches in a 

case-sensitive manner. 

Results: 

 Added a Source Path column to the Details table. This shows the 

full path of the source (e.g. the PST file). This improves reviewing 

of items from a large collection of evidence files, where the 

automatically chosen source name does not provide enough 

information to discern the origin of the information. 

 Speed improvements for reviewing large documents. 

 Speed improvements for quickly iterating over a list of results. 

 Encrypted items are now displayed with a lock icon, to make it 

instantly apparent why no extracted content can be displayed. 

 Applied whitespace normalization to the Contents tab: multiple 

blank lines are reduced to one line; multiple spaces are reduced to 

one space, etc. 

 Reduced memory usage of previewing items. 

 File type icons are now shown in the Type column and in the Type 

facet. The icon depends on the application that is associated with 

that file type on the local machine. 

 The set of near-duplicates of an item no longer contains the item 

itself. 

 Improved the automatically generated name of a set of near-

duplicates. 

 Resolved an issue with the Attachment tab in the Previewer failing 

to print. 

Tagging: 

 The tagging dialogs no longer have a shortcut button that opens the 

Tagging Preferences. Instead, the “Override tag preferences” 

subpanel has been extended with a “remember these settings” 

checkbox. 

 Resolved refresh issues in the tags list and quick tags buttons 

shown in the Previewer. 
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 Resolved an issue with tags not always being propagated to other 

parts of the same mail. 

 Resolved an issue where the Previewer window would disappear 

behind the main window after applying a tag. 

 Improved the display of long tag names in the Previewer. 

Exporting: 

 Added support for export reports in HTML format. 

 Stability improvements for exporting large result sets. 

 Added the ability to let the generated PST be split automatically in 

chunks of a given size. This also improves stability of the export 

process. The export report mentions which PST an item was 

exported to. 

 Optimized the layout of the exported PDFs to improve readability 

and reduce the number of pages. 

 Applied whitespace normalization to exported PDFs: multiple 

blank lines are reduced to one, multiple spaces are reduced to one, 

etc. This improves readability. 

 When exporting to both original format and PDF at the same time, 

the PDF can now optionally link to the corresponding original 

format file. 

 Resolved an issue where the elapsed time and remaining time of 

exporting were not displayed. 

 When exporting a single item, the mouse cursor now changes into a 

busy cursor while it is creating the file. 

 Resolved an issue where an item could not be exported to a PST 

because the parent email could not be found. 

 Resolved an issue where printed results were lacking images. 

 Resolved an issue where embedded items were not exported to a 

PDF when the “Include embedded items” option was switched on. 

 Attachments from EML and MSG files that are exported to original 

format now go into a folder nested in the message’s folder and 

named after the message’s subject (similar to PST, NSF, etc.). 

Before they would go into a numbered folder in the source root 

folder. 
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 When an item fails to export due to some error, it is no longer given 

the Exported status. 

 The Export dialog now has an inline help option to explain what 

happens with email dates when exporting to a PST file. 

 Rephrased some Export to PDF options for clarification. 

 Improved export status messages. 

 The default export folder has been changed from the user’s home 

folder to the Desktop folder. 

General: 

 Improved various error messages. 

 Various changes were made to protect Intella’s databases against 

file corruption when an Intella process is terminated through the 

Task Manager. 

 Improved automatic clean-up of temporary files, usually made 

during indexing and exporting. 

 Various improvements to the information in the log files. 

TEAM: 

 The file numbering option in the Export dialog is now only enabled 

when Original Format and/or PDF is selected. 

 The Tags and Features facets make a better distinction between 

tags, flags and comments made by the case manager and by a 

reviewer. Before, the difference was only clearly visible to the case 

manager. 

2.6.10 Version 1.4.2 

Indexing: 

 Optimized memory usage of indexing of PST/OST/NSF files. 

 Improved text and image extraction accuracy of PDF and MS Office 

files. 

 Improved folder extraction of PST files that are made using the 

Hotmail Connector plugin for MS Outlook. 
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 Resolved an issue with near-duplicate hashing, where generated 

mail sources did not inherit the setting of the original Folder 

source. 

 Resolved an issue with the Refresh operation incorrectly reporting 

removed items. 

Search and Review: 

 The date facet now allows the user to search a date range using 

multiple date attributes simultaneously. Prior to Intella 1.4.2, a 

drop-down list of attributes was provided, allowing the user to use 

only a single attribute per search. 

 The user now has the ability to sort columns in the Details list by 

selecting the new Sort Table button. The user can sort based on 

multiple search criteria in both ascending and descending order. 

The Sort Table button is located in the upper-right corner of the 

details pane. 

 The Intella Previewer contains a new tab called Tree.  This tab 

allows the user to see the entire path, from root to descendants, of 

the selected item being reviewed, along with clickable file names 

and email subjects. 

The tab shows a column with checkboxes that can be used to tag 

multiple items at once. The user can also right-click and choose to 

select all above or select all below the clicked item 

 The ability to search for child items is now available by 

o Right-clicking the search results in the details list and 

selecting Show children. 

o Selecting Show children from the Explore tab of the 

Previewer. 

Show children can search for directly or indirectly nested children. 

The preferred method can be specified in every search or set in the 

Search preferences. 

 The Show parents option now allows the user to specify the level of 

search by selecting top-level parents or direct parents of the 

selected items. This option also allows the user to only consider the 
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emails in the path (ignores items that are not email items) and to 

add all items that are already top-level items to the result. 

 The number of copies is now displayed correctly in the Previewer 

when the number of copies equals 1 (two items with the same 

hash). 

 The Preview tab, which allows the user to preview an item in its 

original layout, will appear for supported file types only. 

Tagging: 

 An inherited tagging feature is now available in the Add tag dialog. 

This feature allow the user to either tag the selected item only 

(item), tag all attached/nested items (item + children), or tag all 

other items nested in the same top-level item (parents + item + 

siblings + children). 

 The user can also choose to automatically tag copies of the item by 

checking Tag all copies. 

 These options can also be configured globally on the Tagging 

preferences tab. 

Exporting: 

 Additional options have been added for exporting to MS Outlook 

PST format. 

o The user can indicate how selected files that cannot be 

exported to a PST file directly should be handled: 

 Replace with its top-level parent email 

 Replace with its direct parent email 

 Skip 

o The user can indicate how selected emails that are also 

attachments should be handled: 

 Replace with its top-level parent email 

 Export the selected attached email 

 The Source, Location and Tags values in exported PDFs are now 

located on the second page of the PDF under Properties. The user 

has the ability to exclude the Properties section when creating PDF 
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exports. This allows potentially sensitive information to be 

excluded from the export. 

 Improvements have been made to the export progress dialog.   

o The dialog no longer blocks the Intella user interface. 

o The elapsed time and the estimated time remaining are 

now displayed. 

 Resolved issues with files that previously could not be exported by 

Intella. 

 Intella no longer places items that fail to export in the Exported 

category of the Features facet. 

 Improved tab printing capability of item contents. 

 The file chooser in the Export dialog is now able to create new 

folders in non-regular Windows folders, such as the Desktop and 

My Documents. 

 After exporting an entire case to an .icf file, a dialog will show the 

path of the created .icf file together with the paths of all evidence 

files that also need to be distributed to those importing the case. 

TEAM: 

 The default TEAM work folder has changed from C:\Users\USER 

to C:\Users\USER\Desktop. 

General: 

 You can now move and resize the Intella user interface when the 

Add New Source wizard is open, e.g. after opening a newly created 

case. 

 If Intella fails to open a case, an improved initialization error 

message will provide the user with possible causes and solutions. 

 Improved the warning dialog that is shown when opening a case 

made with a different Intella version. 

Upgrade Notes: 

 Cases made with Intella 1.4.2 cannot be opened by older versions 

due to changes made to the text indexing. 
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 Existing cases made with earlier Intella versions can be opened by 

Intella 1.4.2 but will require the case to be re-indexed. Tags, flags 

and comments will be preserved when upgrading from 1.4.(1) to 

1.4.2. For cases made with older versions, please check earlier 

upgrade notes. 

2.6.11 Version 1.4.1 

 Resolved an error that could occur during importing of large Intella 

case files (.icf file extension).  Importing of these files would 

typically exit immediately with an error message stating that the 

case file is not valid.  ICF files on which this error occurred will 

have to be recreated with version 1.4.1. 

 Phrase searches using smart quotes are now supported. Such quote 

characters are typically inserted by word processors like Microsoft 

Word when typing the quote character. 

 Resolved an issue with recovered mails from PST/OST files that 

could not be exported. 

 Resolved an indexing error that occurred on empty folders in 

PST/OST files. 

 Intella cannot export to PST files when the full path to the PST file 

is longer than 256 characters. Attempting to do so would result in a 

cryptic export error.  Intella now checks the length of the path and 

gives a more informative error message.  This allows the user to fix 

the path before proceeding with the export. 

 Improved PST/OST indexing debug messages. 

Upgrade Notes: 

 As always, a full re-index of the case is necessary to benefit from the 

changes in this version.  After re-indexing a case made with version 

1.4.0, the database IDs of recovered mails may have changed. 

Consequently, the tags, flags and comments of these recovered 

mails may be lost. 

Regular (non-recovered) PST/OST mails as well as mails from 

other mail sources are not affected; their tags, flags and comments 

will be retained during a full re-index. 
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2.6.12 Version 1.4 

Intella 1.4 delivers significant new features, enhancements and 

performance improvements to Intella. Version 1.4 also introduces a new 

product:  Intella TEAM. 

Intella TEAM enables multiple individuals (reviewers, investigators, 

paralegals, etc.) to review evidence independently and simultaneously.  

Their individual work products can then easily be merged into a single 

result.  Intella TEAM has two components: 

1. Intella TEAM Manager is the primary component and performs 

three critical functions: 

a. Indexing & preparation of the case data or evidence 

b. Sharing of the case data among others 

c. Combining the work product of others 

2. Intella TEAM Reviewers provide the ability to independently 

search, filter, bookmark, tag, and comment on the case data and 

transfer the results of that work back to the TEAM Manager.   

Important Note: Intella TEAM Reviewers CANNOT index or re-index the 

case data.  Only the TEAM Manager can index data. 

Case Management: 

 Indexed evidence files may now be moved and accessed more 

easily.  Previous Intella versions required that evidence files were to 

always be found at the same location, the initially used for 

indexing.  That restriction made moving evidence difficult. 

 Intella will now detect moved files during startup and open a 

dialogue that will enable the user to locate the drives, folders, or 

files. 

 Allows for browsing to existing case folders. 

 Case importing and exporting now checks for available storage 

space before starting the operation. 
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 Case importing and exporting operations now include progress 

monitors and the ability to interrupt the process. 

 When importing cases, the target location can now be specified. 

(Previously, only the default location was possible.) 

 Importing now accepts ZIP files containing an entire case. 

 When importing a case that is already present, a warning is now 

given. 

 The “Remove” button is renamed “Delete” and a clear warning 

message is provided. 

 Error fixes were applied to: 

o Keyword search history and other stored preferences 

related to exporting a case 

o A log file issue related to the use of brackets or other 

special characters in a case name. 

Indexing: 

 Added extraction of images from PDF files. 

 Added support for Foxmail email boxes (.box).  Because Intella 

Rel.1.4 treats .box as a special subtype of Mbox files, use the Mbox 

source type when indexing.  When .box files are contained in a 

folder, Intella will generate the required Mbox source 

automatically. 

 Added support for Apple Mail email boxes (.emlx files).  Because 

Apple Mail stores every email as a single .emlx file, use the Folder 

source to index. 

 Added detection of AppleDouble header files containing Apple 

Resource Forks.   

 Added support for older Outlook Express 4 (.mbx files).  

 Intella-generated source names are now always unique.  Thus 

multiple and different Outlook.pst files will result in sources of 

differing names, e.g. “Outlook.pst” and “Outlook.pst (2)”, etc. 

 Added an artificial X-Intella-Type header to items that actually 

represent other PST/OST artifacts such as notes, tasks, contacts, 

meeting requests, etc. 

 Error fixes were applied to: 
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o Time-out issues with certain email files. 

o Enabled indexing of PSTs containing unnamed folders. 

o Enabled proper indexing of emails with no subject lines. 

Searching and Reviewing: 

 Added a Preview tab in the Previewer window, rendering the 

selected item in its original layout, limited to the first few pages 

(hence “Preview”).  For example, the first few pages of a Word 

document can be shown with its original formatting, embedded 

images, etc.  This functionality is limited to Word, Excel, 

PowerPoint, PDF, RTF, HTML, OpenOffice and WordPerfect files. 

The Preview capability requires MS Office to be installed (Office 

2007 requires PDF Add-in). 
 Added new categories to the Features facet: 

o “Previewed” shows all items that have been opened in the 

Previewer. 

o “Opened” shows all items that have been opened in their 

native application. 

o “Exported” shows all items that have been exported. 

o “Unread” shows all emails that have an unread status in the 

evidence file (applicable to PST/OST only). 

o "Empty Document" identifies all items that have no text 

but where text would normally be expected.  A common 

scenario is a PDF file where all text is contained in images, 

typically a scanned document.  The results of this category 

are typically candidates for OCR or encryption cracking 

tools. 

 Several of the Features facets are now "multi-user aware.”  That is, 

after importing one or more work reports in the Team Manager 

version, you can see which files were previewed, tagged, etc. and by 

whom.  

 Improved memory usage when querying large amounts of items. 

 The Auto-Advance option in the Previewer window has been made 

persistent. 
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 The Previewer now checks for unapplied comments before allowing 

the user to close the window. 

 As a precaution, the tagging, commenting and flagging code verifies 

that those annotations are stored accurately and shows an error 

message when this is not the case. 

 The “Copies” column has been renamed to the more accurately 

“Copies within source”.  Also “Show copies” has been renamed to 

“Show copies within source”.  

 The semantics of the Copies column and Show Copies functionality 

has been changed:  when searching for all copies of an item, the 

item itself is no longer returned. Thus the count is one less than 

before. 

 The “MD5 Hash” facet has been renamed to “MD5 and Message 

Hash”. 

 Changed the Location facet to show the source file names as the 

roots for PST, OST and NSF files. This solves the problem of a large 

list of folders all named “Ext-Root,” now making it apparent which 

email file they relate to. 

 Error fixes applied to: 

o Hit highlighting in the Previewer 

o Missing file names for EML and MSG files in the Previewer 

o Incomplete highlighting of values in the Location facet 

Exporting: 

 Improved the layout of the export dialog to more efficiently use the 

available window space. 

 Exporting to PST has a revised set of options, giving more control 

over what is exported into the PDF. 

 Added the ability to add the original rendering of an item to the 

exported PDF, i.e. the contents of a Word document is shown 

exactly as Word shows it. 

 In Team Manager and Team Reviewer only: added the ability to 

consecutively number exported files, optionally with a prefix and 

given start number. 
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 Exported PDFs have simplified headers and footers – optionally 

only the consecutive number is displayed in the footer. 

 The export order has been improved:  

o First, all items are sorted by source.  

o Next, emails are sorted by Sent date. 

o Each email is immediately followed by its attachments.  

o Each attachment is directly followed by any embedded 

items.  

The order is relevant for export reports and when concatenating all 

exported PDFs into a single PDF. 

 Exporting of results into their original format has been made much 

faster. 

 Improved memory usage when exporting large amounts of items.  

When exporting items while memory usage is already high, Intella 

may suggest removal of the search results from the screen before 

continuing with exporting the selected set.  This frees memory for 

the export process. 

 Improved validation of user-entered information in the export 

dialog. 

 Added a CSV export report type. The CSV report lists all item 

metadata, accompanied by the names of the exported files in 

original format and PDF format.  When using consecutive 

numbering of exported files, the prefix and number is listed as a 

separate column.  Finally, the last column contains any export 

errors that occurred. 

 PDF and RTF export reports now show a divider between the item 

sets of different sources. The PDF report uses headings that appear 

in Adobe Acrobat as bookmarks.  This can be used to quickly jump 

to the items of a specific source. 

 Improved the export folder layout.  Items in their original format, 

PDFs and PSTs, are clearly separated. 

 Error fixes applied to: 

o Fixes for multipart/alternative emails that were missing 

HTML parts when exported. 
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o Fixes for exporting emails with non-Latin content to PDF. 

2.6.13 Version 1.3.4 

 This release contains a fix that ensures that folder names inside 

PST and OST files are indexed, so that you can find emails using 

keyword search on the folder names. Previously this was not done 

for PST and OST files. Other mail formats did not have this 

problem. 

2.6.14 Version 1.3.3 

 Further improvements in recovery of deleted mail from PST/OST 

files. 

2.6.15 Version 1.3.2 

User Interface Improvements and Fixes: 
 

 Tagging Fix:  The “Tags” line in the properties panel of the 

Previewer updates correctly now when the last tag is removed from 

a tagged item. 

 Lotus Notes validation:  Improved user notification makes it clearer 

that Lotus Notes application files are missing or that the detected 

Lotus Notes version doesn't meet the required minimal (most 

current) version. 

 Menu Bar Update Notification Fix:  When the “Update Notification 

Message” on the Menu Bar is selected in Windows 7 the correct 

browser window (on the Vound website) now opens. 

 Case Importing Fix:  A network connection is NOT required when 

importing a case.  

 
Indexing Improvements and Fixes: 
 

 Lotus Notes indexing fixes: 

 Fixed missing last modification dates for attached messages in an 

NSF file. 

 Fixed missing inline images in RichTextItems in an NSF file. 
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 Stability improvements for memory-intensive indexing tasks. 

 Improved PDF text and metadata extraction accuracy. 

 Removed all quotes from the displayed contact name in the Sender 

and Receiver columns in the Details Panel and the Email Address 

Facet 

 
Exporting Improvements and Fixes: 
 

 Stability improvements for the PST creation process.  

 Improved the recovery of deleted mail from PST files, resulting in 

more extracted mail and attachments. 

 Corrected issue that caused exported messages to be labeled 

“unread” when opened in Outlook 2007 and earlier versions. 

 Mbox mail fix:  Corrected folder path of exported Mbox mail to 

remove the path of the Mbox source file. 

2.6.16 Version 1.3.1 

New Features: 

 Comments can now be added to items in the Previewer.  Comments 

are searchable, displayed as a column in the Results table and can 

be exported.       

 Import and Export Cases via the Case Manager to allow cases to be 

shared among multiple reviewers.  An exported .icf file allows easy 

transportability and ensures integrity of the exported case.  The 

import button allows the reviewer to select an .icf file for importing 

into the cases folder. 

 TimeLine View can now be exported as a PNG image 

 Search History can now be selected or turned off by user 

preference. 

 Message ID Column is added to the Results table to display the 

value of the email’s message ID.  If no such header is present in an 

email, the column shows the Mapi-Smtp-Message-Id or Mapi-125-

Message-Id header. 

Improved and Enhanced Features: 
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 The MD5 column in the Results table now only shows the MD5 

hashes of binary items (attached files and electronically stored 

information).  A new Message Hash column shows hashes for email 

messages. 

 The Message Hash algorithm has been rewritten so that the 

Message Hash values will remain constant when a case is reindexed 

with a newer Intella version. 

 Improved the ability to recover deleted mails from PST and OST 

files. 

 Exporting results as PDF files includes several refinements:  

o All PDF output can be concatenated into a single file 

instead of one file per result. 

o Options have been added to control the inclusion of email 

headers, extended properties and comments in the PDF 

document. 

 Results tables that are exported to CSV now use a date format 

recognized by Excel, making it possible to accurately sort on these 

values.   

 The ability to export lists of facet fields and their counts has been 

expanded to all facets.  Enabling a reviewer, for example, to export 

a all document types and their counts, document authors and their 

counts, email addresses and their counts. 

 The Case Manager now shows the size of each case.  A feature of 

particular importance to Intella 10 users. 

 The indexing statistics shown on the interface at the conclusion of 

indexing (number of files, messages, elapsed time, etc.) are now 

added to the log file and available for viewing. 

 Because some facets take additional time to initialize, user activity 

in this state is now disabled so as to prevent incomplete CSV 

exports of these values. 

 The text and metadata extraction accuracy of OpenXML files, also 

known as the MS Office 2007 formats (.docx, .pptx, .xlsx, ...) has 

been improved. 

 Improved the extraction of values from vCards. 
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 Renamed the "Index images inside documents" option to "Index 

content embedded in documents," to more accurately describe 

what is controlled by this option. 

Fixes: 

 Fixed a problem with PST, OST or NSF files that failed to index due 

to a "No response from external process" error. 

 Fixed broken Export to PST functionality due to a conflict with 

another installed application. 

 Fixes for missing receivers in mails from PST/OST files. 

 Fixes for missing dates in MSG files. 

 Fixes for incorrect decoding of mail subjects, senders, receivers and 

dates. 

 Fixes for incorrect representation of encrypted messages in 

PST/OST files. 

 Fixes for incorrect attachments in NSF files. 

 Fixes for the incorrect representation of attached messages in NSF 

files. 

 Fixed problems with previewing mails that lack a subject. 

 Fixed failing indexing of evidence files that have a hash character 

('#') in their paths. 

 Fixed errors with exporting mails from Mbox sources. 

 The Thumbnails tab in the Previewer was sometimes not reset, 

resulting in the Thumbnails of the previous result being shown as 

part of the current result. 

 Korean characters in case names were replaced by dashes in the 

suggested case folder. 

 When Intella detects a version upgrade when you open a case, a 

dialog is opened that suggests reindexing of the case. A problem 

where this dialog appeared every time the case was opened has 

been fixed. 

 When a case was moved to a different location, the ability to show 

thumbnails was lost due to the use of absolute paths in the 

database. Those absolute paths have been replaced by relative 

paths. 
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 Near-duplicate hashes are no longer calculated for items without 

text.  This prevents these items from being considered to be near-

duplicates. 

 The counts in the Features facet were not updated instantly when 

results were tagged, flagged or commented on. 

 The Tags facet should show user names of tag creators, not their 

UUIDs. This only affects exported cases that contain tags. 

 Export reports (RTF and PDF) should use relative paths in their 

links to the exported files, not absolute paths. 

 The Print Preview dialog will now always fit the current display, so 

that no buttons are truncated. 

Upgrade Notes: 

 As usual, when you open a case made with an earlier Intella version 

in Intella 1.3.1, Intella will detect the version upgrade and suggest 

that you reindex. Reindexing is necessary to make use of the many 

improvements outlined above. Two aspects are important to 

consider: 

 After reindexing, the message hashes will differ. We have 

redesigned the algorithm so that this is not likely to occur with 

future version upgrades. 

 Due to the requirement of a particular fix for indexing NSF files, 

some internal IDs of items extracted from these NSF files may 

differ.  A consequence of this is that tags pointing to items from 

NSF files may become incorrect: they may no longer connect to an 

item at all or may connect to a different item.  Should you have 

cases involving tagged items from NSF files, we recommend you 

continue using the previous version for that case or, alternatively, 

completely rebuild the case with Intella 1.3.1. 

2.6.17 Version 1.3 

 Improved case management now allows better editing of case 

details, including investigator name and a case description. 
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 Improved feedback on indexing. Better progress reporting and 

statistics. The dialog that shows during indexing is no longer 

blocking. You can minimize the window now. 

 Improved folder selection in New Source wizard 

 Completely reworked Previewer. Now tasks like tagging, flagging, 

and finding copies of an item are offered in a strip of grouped 

buttons organized in three categories: Review, Explore, and 

Produce. 

 Previewer is now the central instrument for productive reviewing of 

items allowing direct inspection of relations between items. For 

example: the relation between a zip-file and its entries. 

 Previewer indicates the position of search terms in the scrollbar, 

and has Next and Previous buttons to quickly browse search term 

hits. 

 Previewer indicates existence and allows you to navigate to 

duplicates (copies), near duplicates, emails in the same 

conversation, and parent items. 

 Each Previewer can loop over its own results list, so changes in the 

results table have no impact on the operation of the Next and 

Previous buttons of existing Previewers. If the table is still showing 

the same list as when the Previewer was opened, table selection will 

be updated when the Next or Previous buttons are clicked. 

 Improved thumbnail view. Thumbnails are now opened in separate 

previewer window. Like in table view, direct flagging of thumbnails 

and context menu operations are now possible. 

 Thumbnail view shows not only the selected images, but also the 

images embedded in selected documents. This happens recursively, 

e.g., an image embedded in a MS Word document that is attached 

to an email is shown when the email is selected. 

 Extensive tagging functionality added. Tagging can now be done 

with fast tag buttons and keyboard shortcuts in the previewer. 

 New export option added: Export to PDF. This option exports all 

the selected items to separate PDF documents. 
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 Item printing added. You can now print the contents of a previewer 

tab or print a report of the entire item. Added a print preview 

dialog. 

 Ability to find near-duplicates of an item. 

 Features facet added. This facet groups the following items: 

encrypted, flagged, tagged and items that have copies. 

 MD5-list option added. You can now upload a list of MD5-hashes to 

see if these hashes match with the hash value of items in your case. 

 Combined keyword lists are now supported. You can combine the 

results of all the keywords in your list in one results set. 

 Many stability improvements. Lotus Notes 8.5 or higher is now 

required for processing NSF files. 

 Sources panel is now automatically expanded when "No sources 

selected" warning is shown. 

 The Sources facet is now the default facet when a new case is 

opened. 

 New manually defined PST sources have the recovery switch by 

default set to “on.” 

 Intella now automatically detects if Lotus Notes is installed on the 

computer. It is now very simple to configure Intella for Lotus Notes 

NSF files. 

 Support for iCal and vCard added. 

 More information is extracted from PST and OST files, e.g. meeting 

requests, tasks, contacts, and appointments. 

 More information is extracted from Office files: various types of 

embedded objects. 

 Case size limits are added. The evaluation version is limited to 

10 GB. The dongle-controlled version will come in various case size 

limits. 

 Added a License tab in the About dialog (Help > About), showing 

details of the currently active license. 

 Many fixes for non-Latin languages. 

 Support for Intella on Windows 7. 

 As always, many stability improvements! 
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Notes on backward compatibility: 

 When opening a case made with Intella version 1.2.2 or earlier, tags 

made in these versions will not be recognized. 

 The MD5 hashing of email messages is changed in 1.3. The MD5 

hash value of email message made with Intella version 1.2.2 or 

earlier will be different from the MD5 hash value created with 

version 1.3. 

 Some items will have different URI’s compared to URI’s created in 

older Intella versions. 

2.6.18 Version 1.2.2 

 Stability improvements have been made for Lotus Notes (NSF) file 

indexing and exporting. In earlier releases, on rare occasions, an 

NSF file (usually a corrupt file) caused Lotus Notes to crash. When 

that happened, Intella would be shut down as well.  Enhancements 

in Release 1.2.2 will prevent Intella from crashing under that 

circumstance. Under that circumstance, Intella will now continue 

processing the remainder of the file. 

 Note that the Vound Forum contains a number of tips for fixing 

corrupt NSF files.  You can register on the Vound Forum at this 

location:  http://support.vound-software.com 

 New automatic updater that periodically checks for a newer version 

of Intella over the internet. This option may be switched off. 

 The Previewer features several improvements: 

o For archives (e.g., ZIP files), an Entries tab is shown that 

lets the user see and navigate the contents of the file. 

o The Properties tab shows an additional number of 

metadata fields.  

o Icons are shown for known file types, making, e.g., Word 

files instantly recognizable. 

o Finally, a number of usability improvements have been 

made. 
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 Previously, during a Refresh operation Intella would occasionally 

mistakenly report changed items when the evidence files had, in 

fact, not been changed.  This has been fixed. 

 The Add Source wizard remembers the last path of the chosen 

source files. 

 When navigating with the Previewer from result to result, the 

Results table will now adapt its selected row accordingly. 

 The "Export to PST" option is now explicitly disabled when Outlook 

cannot be found, rather than producing errors during export. 

 A number of fixes have been made for retrieving and interpreting 

mail messages and for indexing corrupt ZIP files. 

2.6.19 Version 1.2.1 

Indexing: 

 Extraction and indexing of Word revision logs, consisting of the last 

10 authors and full paths saved to. All authors are listed as 

contributors in the Author facet and both authors and save paths 

can be found using keyword search. Note that not all Word versions 

maintain such a log.  

 Added support for Word 6/Word 95 documents.  

 Prevent caching of images that are directly available in the file 

system.  

 Show elapsed time during indexing.  

 Mistakenly reported unchanged items during indexing of archive 

entries. 

 Broken body extraction of multipart/related messages. 

Searching: 

 Split up the People facet in separate Email Address and Author 

facets.  

 Extended the Email Address facet with lists of all From, Sender, To, 

Cc and Bcc values.  

 Added exporting of encountered email addresses with their 

occurrence count. 
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 The Date facet no longer offers pre-defined date ranges. Instead, 

the custom date range selector has been given a more prominent 

place in the interface.  

 Extended searching for dates: specify whether you want to search 

for file last modification dates, content created or last modified, 

sent or received dates. 

Previewing & Results: 

 Added columns for File Last Modified, Content Created, Content 

Last Modified, Sent and Received dates.  

 Show the full date and time of a timestamp in the Results table, 

rather than only the date.  

 Added Attachments column, showing the names of the attachments 

of a mail.  

 The Attachments tab of a previewed mail now shows the subjects of 

the attached messages.  

 The row number in the flagged column did not match the row 

number shown in the Previewer. 

Exporting: 

 Added "Create new folder" button in the Export dialog.  

 Add all known timestamps (created, last modified, etc.) of each 

exported result in an export report.  

 Export to PST: emails with non-Latin subjects could not be 

exported.  

 Fixed broken export of Chinese mails from NSF to EML.  

 Some emails exported to EML format lacked a Date header.  

 Messages with missing content could not be exported. 

Miscellaneous: 

 HASP license server installation fixes.  

 Some preliminary Windows 7 fixes. Intella now runs on Windows 7 

with a small number of known issues left to be worked out: no log 

file is stored; opening of results in their native application 

sometimes fails. 
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2.6.20 Version 1.2 

 Added an option to recover the deleted items from PST and OST 

files. 

 Index partial mails found in PST and OST files. 

 Added support for indexing Mbox files. 

 Index a folder of mail files: New sources are created automatically 

for each mail file, you are no longer required to add them one-by-

one. 

 Export search results to PST files. 

 Filter visualized results with includes and excludes sets. 

 Added a Timeline view as a fourth type of result view. 

 Added the Keyword Lists facet: search using keywords lists. 

2.6.21 Version 1.1 

 Better performance and stability with new PST and OST crawler. 

 Support for MS Outlook Express DBX files. 

 Support for RAR archives. 

 Preview shows extracted text with search term highlighting. 

 Image extraction from Word, Excel, PowerPoint and OpenXML. 

 Thumbnail viewer as an alternative for the table and list views. 

 Support for Asian languages. 

 Search on arbitrary date ranges in the Date & Time facet. 

 Support for queries that start with a wildcard ('*' or '?'). 

2.7 Feedback 

We take great care in providing our customers with a pleasant experience, 

and therefore greatly value your feedback. You can contact us through the 

form on http://support.vound-software.com/ or by mailing to one of the 

email addresses on the Contact page. 
 

http://support.vound-software.com/
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3 Getting support 

3.1 Different ways to get 

support 

Vound offers four support options designed to assist users that experience 

problems while working with Intella™: 

1. Standard technical support 

2. User support contract 

3. Vound User Support portal 

4. Certified Intella™ training courses 

3.1.1 Standard technical support 

Standard technical support is offered free of charge to all Vound customers 

that have a current support and maintenance contract. 

Standard technical support can be requested at the Vound support page, 

http://support.vound-software.com. 

Support is provided on business days, Monday through Friday. We attempt 

to give you a first answer within 2 business days. 

All communication will be remote – e-mail, GoToMeeting, and other means 

– and not in person unless otherwise arranged.  

Standard technical support will only be provided if your computer and 

operating system meet the minimum recommended specifications listed in 

the latest version of the Intella™ manual.  

Who is eligible for technical support? 

Our goal at Vound is to provide our customers high quality and timely 

technical support. To do this we limit technical support to the registered 

owners of Intella. Companies that allow a third party to use their Intella 
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licenses must have that third party channel all technical support through 

the original registered owner of the software.  

To ensure that we support our customers, Vound regrets it cannot support 

users who are not the original registered owner of Intella.   

What technical support is included? 

 Installation and set-up support limited to one computer in your 

environment. 

 Configuration technical support and user support on use for 

standard Intella™ options. 

 Support for errors in the software (bugs). 

Please note that Vound will make reasonable efforts to correct identified 

software errors. However this may not be achievable until a later date or 

version release.  If this is the case, the user should make efforts and take 

responsibility to achieve the required outcomes via other methods. Where 

the errors relate or are caused by corrupt data (within source files), Vound 

reserves the right to charge for the work needed to rectify the issue.   

No support can be provided… 

 When your computer does not meet the minimum or essential 

system requirements. 

 When you made any kind of modifications to the installed software. 

 When you are not using the software for its intended purpose. 

 When 3rd party applications, like virus scanners, firewalls, and 

other forensic applications, interfere with Intella™. 

 Explaining the method needed to use each feature to achieve a set 

outcome.  

Note: At no time should Vound technical support be seen as legal or 

forensic advice. Our support is given with no knowledge of the specific case 

or matter Intella is being used on. Technical support is focused on the 

correct installation and usage of Intella features.  We do not warrant that 

we are aware of all facts around the case that may be under investigation. 

As such our replies should not be seen as advice or the only way to achieve 

the required outcome. 



Page 73| Intella™ User Manual | © 2012 Vound, LLC 

3.1.2 User support contract 

A paid user support contract is offered to those customers that want 

additional user support. The user support contract provides assistance that 

falls outside the standard support package (see 1.1.1 Standard technical 

support).  

What can be included in the user support contract? 

 Help with the case or setup configuration of Intella™.  

 Assistance in using the basic and advanced features of Intella™ 

such as searching, tagging, and exporting. 

 Help with the installation of Intella™, or help with the 

configuration and set-up of your computer that runs Intella™. 

 Detailed explanation of Intella™ case management and help with 

Intella™ case setup. 

 Help with the export of search results found with Intella™ for use 

with other applications. 

 Support for using Intella™ in combination with software from 

other vendors. 

 Support for issues that a newer Intella™ release has addressed. 

How to buy to a user support contract? 

User support contracts are based on your specific needs. If you want to 

know more, please contact your nearest Vound representative or your local 

Intella™ reseller. 

3.1.3 Certified Intella™ training courses 

Vound offers a number of paid training courses for its product. These 

courses are designed to expand your effectiveness and output when using 

Intella™. It is recommended that all users take a minimum basic training 

course to ensure they are correctly using the product.  

Users who have taken a recent training course for their Intella™ product 

will be offered a discount on a paid user support contract. 

For more information on types of training and available dates please visit 

http://www.vound-software.com/training. 

http://www.vound-software.com/training
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3.2 Working with Vound support 

It is highly recommended that customers and users take advantage of the 

Vound support page when seeking assistance. The support portal takes care 

of collecting all necessary information such as the Intella version, Windows 

version, source types used, etc. and will suggest relevant articles from the 

Intella knowledge base. 

3.3 Upgrade contract 

Vound customers that purchased an Intella license are entitled to install 

free upgrades of the software for a period of one-year. In other words: an 

Intella™ license comes with a one-year upgrade contract. 

After this period purchasing an upgrade subscription will continue the 

upgrade contract. Please contact your nearest Vound representative for 

more information. 

Please know that you will only have access to standard technical support if 

you have an upgrade contract. 
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4 Installation and 

configuration 

4.1 Installation 

4.1.1 Step 1: Check the requirements! 

 Operating systems 

Intella is supported on the following operating systems: 

o Windows 2000 

o Windows XP 

o Windows Vista 

o Windows 7 

 

 Minimum hardware configuration 

The minimum hardware configuration is a system with an Intel 

Core 2 Duo, 2 GHz with 2 GB of RAM. 

 

 Recommended hardware configuration 

The recommended hardware configuration is a system with an Intel 

i7 CPU with 8 GB of RAM and 2 GB of HD space. Allow extra space 

for case files and evidence data. 

 

 No need for Microsoft Office installation 

No Microsoft Office installation is required to index PST/OST files 

or any MS Office document formats. 

For exporting to PST files, Microsoft Office 2007 or higher (2010 is 

recommended) still needs to be installed locally. 

 

 Lotus Notes 8.5 or higher 

In order to index NSF files, Lotus Notes 8.5 or higher is required. 
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Only the application files are necessary, Notes does not have to be 

fully setup to be used by Intella. 

Note: Intella needs to know the location of Lotus Notes in order to index 

NSF files. Please go to File > Preferences > IBM Lotus Notes to check if the 

location is validated. 

4.1.2 Step 2: Learn about licenses and 

dongles 

Notes on the trial license that is bundled with the software that you have 

downloaded: 

 14-Day evaluation period. 

The trial version runs under a HASP Software License, which gives 

you the ability to use Intella for 14 days. The 14 days evaluation 

period cannot be extended. The only way to continue using Intella 

is to purchase a dongle. 

 Trial restrictions. 

Besides the 14 days of usage, the trial only allows 10 GB of evidence 

files per case. Also, exporting is limited to maximally 1000 items 

per export. 

 Continue working with a USB dongle. 

If you would like to continue using Intella after this 14 day period, 

you will need to buy a license. After buying the license you will 

receive a USB dongle that will allow you to continue using the 

version you already installed. A dongle provides a perpetual license 

without export restrictions. Case size restrictions may still apply, 

based on the licensed product. 

 System clock. 

Changing the clock on your system will cause the trial to 

automatically expire. When this occurs, the only way to continue 

using Intella will be to purchase a license.  

 Virtual Machines, VMware. 

The evaluation version will not work in VMware without a dongle.  
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 RDP (Remote Desktop Protocol) connection. 

The Intella evaluation version can only operate over an RDP 

(Remote Desktop Protocol) connection with a licensed dongle. The 

trial license cannot be used over RDP. The dongle must be in the 

computer running the Intella software, not in the computer 

running the RDP viewer. 

 Other dongle-protected software must be closed 

All other HASP protected software, like EnCase (Guidance), Smart 

Mount (ASR Data), HBGary and i2 products, must be closed when 

installing Intella.  

4.1.3 Step 3: Install the software 

1. Download Intella through the download page on the Vound 

website: http://www.vound-software.com/ 

2. Double-click on the downloaded .exe file to launch the installer. 

Accept the license.  

3. Enter the location to store the application files and shortcuts or 

accept the default settings. All files will be extracted to the location 

of your choosing and an Intella shortcut is (optionally) placed on 

your desktop and in your Start menu. 

The application folder contains an executable called "Intella.exe" that can 

be used to launch the application. The desktop and menu shortcuts also 

start this executable. The program will start with the Case Manager 

window. 

Important: Intella will not install in an installation folder of an earlier version. 

Install a new version of Intella in a folder with a new name, for example: 

 

C:\Program Files\Vound\Intella 1.6.1\ 

 

It is possible to install multiple Intella versions side by side. 
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4.2 Installation troubleshooting 

4.2.1 Error code 7 (H0007) 

"HASP key not found (H0007)" 

This error code might be caused by other HASP dongle protected programs. 

Please close down all HASP related programs (i.e. EnCase, Smart Mount) 

and reinstall Intella. 

4.2.2 Error code 27 (H0027) 

"Terminal services detected, cannot run without a dongle (H0027)" 

This error code may be triggered because you are trying to use Intella via a 

remote desktop connection. Intella will only run via a RDP or terminal 

session with the dongle in place. 

4.2.3 Error code 31 (H0031) 

“Could not find a valid Intella license, please insert a dongle” 

This error message is shown when your trial license has expired, or when 

you unplug your dongle while Intella is running and it cannot fall back to a 

non-expired trial license. You can only continue using Intella by inserting a 

dongle. 

4.2.4 Error code 33 (H0033) 

"Unable to access HASP SRM Run-Time Environment (H0033)" 

This error code may be triggered if you run antivirus software. It is 

probably due to the antivirus software incorrectly blocking access to the 

HASP install. Please update your antivirus software to the latest virus 

definition file. 

If this problem persists, reboot your computer, open a Command Prompt 

and run (as administrator)  

<intella-dir>\bin\haspdinst.exe -i -kp 

and restart Intella. 
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4.2.5 Error code 37 (H0037) 

Other HASP dongle protected software may cause this error. Please close 

down all HASP related programs (i.e. EnCase, Smart Mount) and reinstall 

Intella. 

If this problem persists, open a Command Prompt and run (as 

administrator)  

<intella-dir>\bin\haspdinst.exe -i -kp 

and restart Intella. 

Tip: To open a Command Prompt and run as administrator (in Vista and 

Windows 7), please select Start > Accessories > Command Prompt. Right click 

and select "Run as administrator.” 

If problem persists after running this command, please open a Command 

Prompt as administrator and run 

net start hasplms 

4.2.6 Error code 41 (H0041) 

"Your Intella (trial) license has expired (H0041)" 

This error will be triggered if Intella is run and your trial license has 

expired. Once the trial has expired, you can only continue using Intella by 

inserting a dongle. 

4.2.7 Error code 51 (H0051) 

"Virtual machine detected, cannot run without a dongle (H0051)" 

In order to protect our intellectual property, the evaluation version of 

Intella WILL NOT run in a virtual machine (VM) environment. A “stand-

alone” machine is required. This is only true for the evaluation version; 

Intella will run in a VM environment using a dongle. 

Solution 1: Reconnect the USB dongle to your computer 

Solution 2: Install the Intella evaluation version outside a virtual machine 
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4.2.8 Memory settings 

The Intella process and its child processes are limited by the amount of 

RAM that the process can maximally use, despite how much memory is 

installed in the machine. On some data sets this limitation can cause issues 

when indexing or reviewing the data. These issues can be recognized by 

errors in the log files containing the text “OutOfMemoryError” or “java 

heap space”. 

When such errors occur, a workaround may be to increase the memory 

thresholds, especially when the machine meets the recommended hardware 

settings (at least 4 to 8 GB of RAM). 

To increase these thresholds, locate the Intella.l4j.ini file in Intella’s 

program files folder and open it in a text editor. You will typically need 

administrative privileges to edit this file. 

Locate the following line: 

-Xmx1024M 

The number shown here may be different, depending on the Intella version 

that you use. With the 32-bit version of Intella you can increase this 

amount to 1300 MB. Higher values may result in Intella not starting 

anymore, regardless of whether Intella is running on a 32-bit or 64-bit 

Windows platform. 

With the upcoming 64-bit version of Intella you can use larger values. It 

will likely not make sense to use values larger than 4096 though. 

If the memory issue relates to the extraction of items from PST or NSF files 

(you may need to contact tech support for that diagnosis), then locate the 

following line: 

-Dintella.serviceMaxHeap=600M 

Increase this number to a higher value, again not going above 1300M for 

32-bit Intella. 
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4.2.9 Where are Intella's data files located? 

There is an Intella data folder in your home folder. The actual path to this 

folder depends on your platform. 

 Windows Vista and Windows 7 

C:\Users\<USERNAME>\AppData\Roaming\Vound\Intella 

 

 Windows 2000,  XP 

C:\Documents and Settings\<USERNAME>\Application 

Data\Intella 

4.2.10 Where can I find Intella’s log files? 

Intella has two types of log files: 

 Case-specific log files. These will contain any messages (errors, 

warnings, status messages) relating to your activities in the case, 

such as indexing, searching and exporting. They are located in 

…\Intella\cases\<CASE FOLDER>\logs 

 

 Log files of operations performed in the Case Manager, such as 

exporting or importing a case. These are located in 

…\Intella\logs 

The log files can be opened in any text editor like TextPad or Notepad++. 

Be aware that Windows’ default text editor Notepad has issues opening 

large files. 

Tip: Click Help > Open Log Folder to open the log folder of the current case. 

4.2.11 What is required to run Intella? 

1. Operating systems. 

Intella supports Windows 2000, XP, Vista, Windows 7. 

 

2. Minimum hardware requirements. 

The minimum hardware configuration required is an Intel Core 2 
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Duo 4, 2 GHz with 2 GB RAM. 

 

3. Recommended hardware requirements. 

The recommended hardware configuration is an Intel i7 CPU with 

8 GB RAM or better. Intella requires 2 GB of HD space. Additional 

disk space will be required for case files and user data. 

 

4. Microsoft Office is no longer required. 

Microsoft Office 2007 is no longer required to index PST and OST 

files as it was in previous versions. 

Note: If you intend to export to PST files you will need Microsoft Office 2007 

installed on the same computer. 

5. Lotus Notes 8.5 or higher. 

In order to index NSF files, Lotus Notes 8.5 or higher is required. 

4.2.12 How to add a Lotus Notes NSF source? 

If you want to index Lotus Notes NSF files Lotus Notes 8.5 needs to be 

installed on your computer. Only the application files are necessary, Notes 

does not have to be fully setup to be used by Intella. 

If the "Lotus Notes NSF file" option is grey in the Add New Source wizard, 

please check File > Preferences > IBM Lotus Notes tab. If the status is not 

“OK”, please click Browse… and select the correct path to the installation 

folder of IBM Lotus Notes. 

4.3 Other frequently asked 

questions 

4.3.1 How is a file type determined? 

Intella looks for certain binary markers (so-called magic numbers) that 

identify certain file types regardless of the file extension (e.g., .pst, .doc, 

etc.). When this detection process fails to produce a detected file type, 
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Intella uses a list of known file types by file extensions. Intella may not be 

able to determine the file type of files with non-standard (unknown) file 

extensions. 

4.3.2 Why are some characters ignored in 

search queries? 

This is caused by what is called the analyzer: before an item can be indexed, 

the analyzer breaks down the text in order to determine the individual 

words used in it. This analyzer discards white space, punctuation 

characters, etc. The same analyzer is also used to break down your query 

into individual terms. 

As non-letters and non-digits are ignored, for example, the queries 

“searchterm,” “searchterm/” and “searchterm ” (with an extra space at the 

end) all end up being equivalent. 

4.3.3 How about live indexing (F-Response 

and Intella)? 

Some cases may require you to index files while the computer is being used, 

or across a network. For such cases we have made Intella to work with the 

best-of-breed application F-Response, by Matt Shannon. This combination 

provides you with a live forensic solution for under $300. 

You can obtain F-Response at www.f-response.com. 

4.3.4 How about email attachments? 

Intella will search both the email and the attachment for the keyword(s) 

and metadata. 

4.3.5 Can Intella deduplicate search results? 

Yes, Intella can deduplicate search results. During indexing, the checksum 

(hash) of every item is stored. Intella can be set to show or hide duplicates 

while you use it. Intella uses the MD5 hash to calculate checksums. 
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4.3.6 Can Intella index an Encase image? 

Using an image mounting tool like Andy Rosen's SmartMount, Intella can 

index the Active files only. To index the unallocated you should first carve 

the image, save the data to a folder, and index that along with the image 

using Intella. 

4.3.7 Are there any EnScripts for use with an 

Encase image? 

In collaboration with a number of users Vound has created an “Export to 

Intella” EnScript. The EnScript is freely available for Intella users. Please 

contact our support department for a download link. 

This EnScript Package is designed to provide a simple, yet powerful, 

method to export relevant electronic files, including email, documents, and 

images, from EnCase to Intella for efficient investigatory review prior to full 

forensic analysis. 

4.3.8 How to print and export PDF reports 

with characters of my language? 

By default, Intella supports printing and PDF generation for basic Latin 

character set only. To enable printing and PDF export for a language with 

another character set, you need to install an additional Unicode font that 

supports your language. 

1. Download the font file and install it in your system 

2. Copy the font file to the font subfolder of your Intella installation: 

C:\Program Files\Vound\Intella\font 

3. Restart Intella 

The font must be a Unicode TrueType font with ".ttf" file name extension. It 

is recommended that the Intella font folder contains only one font file. 

Recommendations for font selection: 

 For other languages than Chinese, Japanese or Korean, it is 

possible to install a single universal font supporting a broad range 
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of character sets. You can take a look at the GNU FreeFont font 

collection at http://www.gnu.org/software/freefont/. 

 For Chinese, Japanese or Korean languages it is recommended to 

install a language-specific font. A large list of fonts for different 

languages and writing systems is available at 

http://www.wazu.jp/.If you already have the native font installed 

on your Windows system, you can copy it from 

"C:\Windows\fonts" to the Intella "font" folder. 
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5 Dongle activation 

Overall process 

To protect our intellectual property, dongles may not be activated when 

shipped. In that case it is necessary to activate your Intella dongle in order 

to use Intella. 

5.1 Dongle Manager 

Intella ships with a Dongle Manager application. The Dongle Manager will 

list all connected Vound dongles and what products they currently contain. 

When the PC running the Dongle Manager is connected to the Internet, it 

can also contact the Vound license server to check for any updates for a 

dongle. These updates are then downloaded and applied automatically. 

The Dongle Manager is located in the Intella program folder 

(on Windows 7:  C:\Program Files (x86)\Vound\Intella 1.6.1): 

A shortcut to the Dongle Manager can also be found in the Start menu. 

After starting the Dongle Manager, the following screen will appear: 
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This screenshot shows a typical setup where only one Vound dongle is 

connected. When multiple dongles are present, they will each be listed 

separately in this list. 

Click on Blink to see to which physical dongle an entry in the list 

corresponds. This will cause the LED in the represented dongle to blink 

rapidly. This can be useful when you have multiple Vound dongles plugged 

in or are using HASP dongles from a different Vendor. 

Show Products will list the licensed products on that dongle. All products 

typically have a perpetual license; hence no license restrictions are 

displayed by the Dongle Manager. 

To update your dongle, click on Check for Updates. This will contact the 

Vound license server and download and apply any updates. When the 

process has finished, the Dongle Manager will show which products, if any, 

have been added to the dongle. The update procedure will only add new 

licenses to the dongle; it will leave your existing licenses untouched. 
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When you are on a network using a proxy, Intella will automatically try to 

detect and use it. If this fails, the proxy settings can still be set using the 

“Configure proxy settings…”. Consult your IT admin for further 

instructions. 

5.2 Using haspupdate.exe 

If your agency/company is structured such that the dongle cannot be 

updated in this fashion, please follow the steps below. 

Step 1: Collect your dongle and license information and send 

it to Vound Support at: support@vound-software.com. 

 

1. Plug your dongle into an available USB port. 

 

2. Start “haspupdate.exe”. You will find haspupdate.exe in the bin 

folder in the installation folder of Intella. The default installation 

folder is: 

C:\Program Files\Vound\Intella 1.6 

 

3. Click the Collect Key Status Information tab. 

 

Click Collect information. 
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4. In the next dialog you will be asked to “Save key status as”. Please 

save the file with your company 

name. If you are activating more 

than one dongle please number 

the files. The file(s) you create 

will have a c2v file extension. 

 

Example: 

ACME_Forensics_1.c2v 

ACME_Forensics_2.c2v 

 

 

 

 

 

5. After you clicked “Save”, you will see the “Select HASP” dialog.  

Please select HASP HL, not HASP SL! 

 

6. Record the dongle ID numbers for each dongle. This will help when 

applying the update files. 

 

7. Send the created c2v files to support@vound-software.com. 

Please ensure you include the following details in the email when 

sending the c2v files: 

 

mailto:support@vound-software.com
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a. Organization Name  

b. Address 

c. Zip code 

d. Country 

e. Contact Name 

f. Phone Number 

g. Email Address 

h. Vound Product type  –  select only one per dongle: 

i. Intella 10 GB 

ii. Intella 100 GB 

iii. Intella 250 GB 

iv. Intella Professional 

v. Intella Viewer  

vi. Intella TEAM Manager 

vii. Intella TEAM Reviewer 

 
 

Step 2: Apply the license update file(s) you receive from 

Vound Support. 

 

1. Make sure your dongle is connected to the computer that runs 

Intella. 

 

2. Vound Support will send a dongle activation 

file. The activation files are dongle-

specific. The file will end with a .v2c file 

extension and the name of the file contains 

the dongle ID. 

 

Example: 

HaspUpdate_68_304466763.v2c 

(the dongle ID in this case is 304466763) 

 

Save the .v2c file on your computer. Be sure 
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to remember where it is stored! 

 

3. Start "haspupdate.exe" as before. 

 

4. Click the “Apply License Update” tab. Then click the Browse button 

labeled “…” next to the “Update File” field. This opens a file selector 

dialog. 

 

5. Select the .v2c file in the file selector and click Open. 

 

6. Click “Apply update” button. This will activate the dongle. 

 

 

Your Intella dongle is now activated! 

In case of questions or problems, please contact Vound Support at 

http://www.vound-software.com/intella/support. 

 
  

http://www.vound-software.com/intella/support
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6 Intella editions and 

their workflow 

6.1 Feature Overview 

 10 

GB 

100 

GB 

250 

GB 

Professional Viewer TEAM 

Manager 

TEAM 

Reviewer 

Preparation 

   Case size limit 10 

GB 

100 GB 250 GB none none none none 

   Create new cases ● ● ● ●  ●  

   Index evidence files ● ● ● ●  ●  

Investigation 

   Search, filter & review ● ● ● ● ● ● ● 

   Preview items ● ● ● ● ● ● ● 

   Flag & tag items ● ● ● ● ● ● ● 

   Export items ● ● ● ● ● ● ● 

Cooperation 

   Export Cases ● ● ● ●  ● ● 

   Import Cases ● ● ● ● ● ● ● 

   Share Cases      ●  

   Connect to Shared Cases      ● ● 

   Export Work Reports      ● ● 

   Import Work Reports      ●  
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6.2 Intella 10 GB/100 GB/250 

GB/Professional 

6.2.1 Description 

Intella 10, 100 or 250 GB and Intella Professional are the powerful, 

standalone editions. They allow you to create cases, index evidence files, 

search, filter, flag, tag, comment on, and export items. 

The number in the product edition name indicates the amount of gigabytes 

of evidence files that each case can hold. Intella Professional has no such 

limit. 

Each of these editions can also be used to prepare cases that are reviewed 

using Intella Viewer. 

6.2.2 Workflow 

For standalone use: 

1. The investigator creates a case in the case manager of Intella and 

indexes evidence files. 

2. The investigator flags and tags items, and gives comments to items 

of interest. 

3. The investigator exports the results for further processing of the 

case. 

In combination with Intella Viewer: 

1. The administrator creates a case in the case manager of Intella and 

indexes evidence files. 

2. The administrator exports the case to an Intella case file (.icf file) 

using the case manager and informs the investigator where he can 

find the case file. 

3. The investigator imports the case file in Intella Viewer. The 

investigator flags and tags items, and gives comments to items of 

interest using Intella Viewer. 
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4. The investigator exports the results using Intella Viewer for further 

processing. 

6.3 Intella Viewer 

6.3.1 Description 

Intella Viewer allows the investigator to work on a case that is created by 

Intella 10/100/250 GB, Intella Professional or Intella TEAM Manager.  

6.3.2 Workflow 

In combination with Intella 10/100/250 GB, Intella Professional or Intella 

TEAM Manager: 

1. The investigator imports an Intella case file (.icf file) that is created 

with any Intella product capable of creating case files. 

2. The investigator flags and tags items, and gives comments to items 

of interest.  

3. The investigator exports the results for further processing of the 

case using Intella Viewer (Export > Result List…). 

6.4 Intella TEAM Manager and 

Intella TEAM Reviewer 

6.4.1 Description 

The Intella TEAM products make it possible to work with multiple 

investigators on the same case. In order to do so you need Intella TEAM 

Manager for the case administrator and Intella TEAM Reviewer for the 

investigators in your team. 

The case administrator creates the case in Intella TEAM Manager and 

indexes the sources with evidence files. The investigator opens the case 

created by the administrator with Intella TEAM Reviewer and starts to 

work on the case. 
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The administrator has two options for giving the investigator access to the 

case: 

1. Share the case over the network. The investigator uses his Reviewer 

to connect to the running Manager instance. 

2. Export the case folder for use by the investigator. No network 

access between the Reviewer and Manager is necessary, but setting 

up the investigator’s machine and sharing his work results like tags 

and comments will take more time and effort. 

6.4.2 Workflow of sharing cases over a 

network 

1. The case administrator creates a case in Intella TEAM Manager 

using the case manager and indexes the evidence files. 

2. The administrator closes the case and returns to the Case Manager 

screen. The administrator selects the case and clicks Share… In the 

screen that follows, the administrator selects a freely available port 

and a passphrase for controlling access to the case. Finally, the 

administrator clicks Start Server, which displays the Case URL that 

the Reviewers can use. 

3. The case administrator informs the investigators of the Case URL 

and passphrase of the case. 

4. The investigators start Intella TEAM Reviewer and choose to open 

a shared case, filling in the Case URL and passphrase provided by 

the administrators. 

5. Investigators flag, tag items and comment on items of interest. All 

these actions are stored immediately in the central case and will be 

visible to other investigators. 

6.4.3 Workflow of sharing cases offline 

6. The case administrator creates a case in Intella TEAM Manager 

using the case manager and indexes the evidence files. 

7. The case administrator exports the case to an Intella case file (.icf 

file) and informs the investigators where they can find the case file. 
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8. The investigators use Intella TEAM Reviewer to import the Intella 

case file. 

9. Investigators flag, tag items and comment on items of interest. 

They export an Intella work report (.iwr file) that holds these 

annotations. 

10. The case administrator opens the case in Intella TEAM Manager 

and imports all the Intella work reports created by the 

investigators. The administrator exports the combined results for 

further processing of the case. 

6.4.4 Work reports 

When sharing cases offline, work reports are essential in merging the work 

product of all investigators working on the same case into the master copy 

of the case. 

Exporting work reports 

Exporting an Intella work report means that an *.iwr file is created (Team> 

Export Work Report…). This file contains all tags, flags and comments 

given to items by an investigator. We refer to these types of information as 

“item updates” as they extend the stored item metadata. 

Furthermore it contains the user actions on items that can be found in the 

Features facet (Previewed, Opened and Exported). 

Finally, the audit trail is added, allowing for more precise investigator 

audits. 

In the Export Work Report dialog you can set the file name of the work 

report that is to be created. 

When you select the option Create CSV report, a CSV file will be created 

that contains a list of all the items that are flagged, tagged or commented. 

This CSV file lets the investigator double-check the tags, flags and 

comments that are contained in the work report. It is not necessary to give 

this CSV to the case administrator, only the .iwr file will suffice. 
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In the second section you can choose 

what type of updates will be reported: 

tags, flags, comments, action statistics, 

saved searches and an audit log. You 

can further specify what tags should be 

in the report by clicking the Select 

button. 

In the third section you can 

(optionally) further restrict the item 

updates included in the work report. 

 By selecting Also include 

updates from these reviewers 

and by selecting one or more 

names after clicking the Select 

button, the work report will 

also contain annotations made 

by the selected investigators. This option is disabled when your 

case does not contain updates made by other reviewers. 

 Only include updates made between … and … allows you to restrict 

the work report to updates that were made in a specified date 

interval. 

 Only include updates in these sources allows you to limit the report 

to selected sources only. 

 Only include updates from items selected in the Details view 

allows you to filter the report to the items that are currently 

selected in the Details panel. 

Creation of the work report may take some time, depending on the case size 

and the amount of updates. Afterwards a dialog is shown that lists the 

created files and statistics on how many tags/flags/etc. are stored in the 

work report. 

Importing work reports 

Importing work reports means that work report files (*.iwr files) created by 

investigators are added to the original case managed by the case 
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administrator. Flags, tags and comments, audit logs and statistics 

generated by an investigator are imported into the case. In this way, the 

results of a team of investigators can be combined. 

Use Team > Import Work Report… menu entry will show the Open dialog. 

Select a work report and click Open.  

Important: You can only import work reports that belong to the same case. 

The Work Report History dialog shows a list of imported work reports.  Use 

to Team > Work Report History… to open this dialog. 

When you want to delete the results imported from a work report, select the 

work report in the list and click “Remove Work Report contents”. Since this 

operation can’t be undone you will be asked to confirm. 
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7 Managing Cases 

A case is a collection of sources that can be searched by Intella. Use cases to 

organize your investigations. 

When you start Intella, the Intella Case Manager will first show up. Here 

you can select existing cases, define new cases, remove old ones, share and 

export cases. 

 

The icons represent local cases (folder icon), remote cases (TEAM icon) and 

old cases (grayed-out folder icon). If the case is made with 1.5.x, it can be 

converted, as indicated by the message following the case name. 

Below the cases list you can see the ID of your dongle. This can be relevant 

in conversations with Vound’s support department. When you are using a 

trial license, this line will reflect that. 
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When you have your dongle inserted but still see a line indicating that you 

are using a trial license message, this could indicate technical problems 

with accessing the dongle, but also that your dongle needs to be updated to 

run with this Intella version. 

7.1 Adding cases 

To create a new case, select “Add” in the Case Manager window. The Add 

Case options will appear. It shows the four ways of adding a new case to 

Intella: 

1. Create a new, local case from scratch. Use this to index a new set of 

evidence files on your machine. 

2. Open a shared case. With this option you can connect to a case that 

is shared by a TEAM Manager user. This option is only available 

when running Intella with a TEAM Manager or TEAM Reviewer 

license. 

3. Add an existing case. Use this when you have a case folder already 

on your system but it is not yet in the list of cases shown by the 

Case Manager. 
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4. Import a case. Use this when you have received a copy of a case 

from another investigator as an ICF file. Importing the ICF file will 

extract its contents into a local case folder and add the case to the 

Case Manager’s list. 

7.1.1 Creating a new case 

Choose “Create a new case” to create a new local case from scratch.  When 

the Create New Case dialog is displayed, give the case a name, enter an 

optional description, enter an investigator name (defaults to your Windows 

user name) and select a location where you want to store the data that 

belongs to this case. 

 

Note: The default location for data storage, visible when you click the Suggest 

button, is 

C:\Documents and Setting\<username>\Application Data\Intella\cases\ 

or 

C:\Users\<username>\AppData\Roaming\Intella\cases 
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7.1.2 Opening a shared case 

In the Add Case dialog, select “Open a 

shared case” to open a case on another 

machine that has been shared by a TEAM 

Manager user. 

A “Create new case” dialog will open that 

asks for a Case URL and passphrase. This 

information should be provided to you by the 

case administrator (typically the TEAM 

Manager user). 

Check the “Remember passphrase” checkbox 

if you want to store the password locally, so 

that you don’t have to re-enter it each time 

you select the case in the Case Manager and 

click Open. 

Click “Check connection” to test the URL and 

passphrase. If the credentials successfully give you access to the case, a 

“Connection OK” status message will display and the case name and 

description will be loaded from the server. 

Click Suggest or enter a custom data folder for local storage. This folder will 

hold local log files, user preferences, etc. 

Now the case will be added to the Case Manager list and will open instantly 

when you keep the “Open case immediately” checkbox selected. 

7.1.3 Opening an existing case 

In the Add Case dialog, select “Add an existing case”.  This will open a 

dialog prompting you to choose a case file (case.xml).  This file is located in 

the top level case folder. Choose the case file and click on Open. 

7.1.4 Importing a case 

In the Add Case dialog, select “Import a case”.  This will open a dialog 

prompting you to choose an Intella case file (.icf file).  Choose the case file 
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and click on Import. Once importing has completed, the case will be added 

to your Case Manager’s case list. 

7.2 Editing a case 

In the Case Manager, use “Edit…” to open the “Edit case” dialog to change 

the name, description, and the investigator’s name. 

You cannot change the Data folder. For remote cases the case name and 

case description cannot be changed. 

7.3 Deleting a case 

In the Case Manager, use “Delete” to remove the selected case(s) from the 

Case Manager’s cases list. You will be asked to 

confirm the deletion. 

By default, only the reference to the case is 

removed, the case folder is left intact. By checking 

“Also remove the related case folders from disk”, 

the case folder will be permanently removed as 

well. 

Warning: removal of the case folder cannot be 

undone. Also, all files that you may have placed 

manually in the case folder will also be removed. 

7.4 Exporting a case 

In the Case Manager, use “Export” to export the selected case. Choose a 

name and folder for the ICF file in the “Choose file to export the case” 

dialog and click Save. 

Once the case file has been created, a dialog is shown that lists the location 

of the created ICF file. This file is to be handed out to the investigators that 

need to work on this case. 
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The dialog also lists the location(s) of the evidence file(s) used in the case. 

These only need to be distributed when the receiver of the ICF file needs to 

be able to reindex the case. For all other tasks, including exporting, the case 

is fully self-contained. 

7.4.1 Sharing a case 

In the Case Manager, use “Share” to share the case for other TEAM 

Manager and TEAM Reviewer users. 

You will be prompted for a Port number and Passphrase (this is a password 

you create). 

The port needs to be freely available; you will get an error when trying to 

share a case on a port that is already in use by another application. When 

sharing multiple cases, each case needs its own individual port. Also the 

port needs to be reachable for other machines. This may involve setting 

some firewall rules on both machines. 

The passphrase can optionally be stored. This means that it will already be 

filled in the next time you start sharing the case. 

All Reviewers will be using the same passphrase to connect to the case. This 

security model will be extended in future releases. 

Click on Start server to begin sharing the case. If there are no errors, this 

will show a “Server started” status message. Also one or more 

recommended case links will be shown derived from the machine IP 

address(es) and the selected port. In most networks, one of these links can 

often be used by the other investigators, together with the passphrase, to 

connect to the case. Only in non-trivial network setups a different link may 

be necessary to connect to the case, e.g. a different IP address that the 

system could not determine itself, or a different port number because of 

port forwarding in a router. Contact your network administrator for 

assistance. 
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Click the Copy Case Invitation to generate a text with instructions for 

reviewers to connect to the case. The invitation text will include the case 

links and the passphrase and will be copied to the clipboard, from where it 

can be copied into an email, document, chat message, etc. 

When investigators connect to the case and start to query, review and 

export, the events list beneath the Status line will start to show events about 

user activity. 

The case remains shared until the TEAM admin clicks the “Stop server” 

button. 
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Selections panel 
shows user’s 

queries. 

Facet panel 

shows a list of 

facets for 

searching and 

filtering results. 

The values or 

the selected 

facet are shown 

below the list. 

Details panel shows a 

table, list, thumbnail or 

timeline view of the 

results in a selected 

cluster. 

Search panel is the 
place to enter a word 

or phrase to search for. 

8 Overview of the 

Intella interface 

8.1 Main window 

  

Cluster Map panel shows how 

search results are connected to 

parts of the query. 
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8.2 Previewer 

 

Item summary: 

shows summary 

of important 

information 

related to the 

item. 

Previewer window: 

opens when item in 

table is double clicked. 

Search term hit: 

Location of search 

terms in the text. 

Item tabs:  

inspect an item’s contents, 

headers, properties, 

attachments, thumbnails, 

tree structure, extracted 

terms, comments and 

performed user actions. 

 

Previewer 

actions: click 

Review, Explore 

or Produce to see 

Previewer actions. 
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9 Sources 

Sources are one of the key concepts of Intella. They represent the locations 

where items such as emails, documents and images can be found. Sources 

are explicitly defined by the user, providing full control over what 

information is searched. 

9.1 Source types 

Intella distinguishes between various types of sources: 

 Folder sources: Directory (folder) on a local hard drive or on a 

shared/network drive containing one or more source files. 

 

 MS Outlook file (PST, OST): Storage files used by Microsoft 

Outlook for storing email and other Outlook data. 

 

Supported versions 

Intella supports PST and OST files created by the following 

versions of Microsoft Outlook: 97, 98, 2000, 2002, 2003, 2007, 

2010. 

 

 MS Outlook Express file (DBX, MBX): Email folder files for 

Microsoft Outlook Express. 

 

Supported versions  

Intella supports DBX files created by the following versions of 

Microsoft Outlook Express: 4.0, 5.0, 6.0. 

Tip: If you want to index Windows Mail files, please create a Folder 

source and index the folder where Windows Mail stores the messages. 
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 Lotus Notes NSF file: Email database file for Lotus Notes. In 

order to index NSF files, Lotus Notes 8.5 needs to be installed.  

 

Supported versions: 

Intella supports NSF files created by older versions of Lotus Notes. 

Intella supports all NSF files that can be processed by Lotus Notes 

8.5.  

Tip: The Lotus Notes tool “nudall.exe” can be used to convert older 

NSF files to NSF files that can be processed by Lotus Notes 8.5. 

 Mbox file: Storage file for Mozilla Thunderbird, Foxmail and 

other email applications. Intella has been tested on Thunderbird 

Mbox files. 

 

 IMAP account: One or more email account(s) on an IMAP email 

server. 

Important: The IMAP standard is implemented in many different ways. 

We tested Intella on several IMAP servers with good response. 

However, we cannot guarantee that Intella is able to create IMAP 

account sources for every IMAP server. 

 Cellphone XML report(s): one or more Cellebrite, XRY or 

Oxygen dumps, exported to XML. 

9.2 Adding sources 
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Adding sources to Intella is done with the Add New Source wizard. You can 

start this wizard by selecting “Add New…” from the Sources menu or by 

typing CTRL+N. 

 

9.2.1 Adding a Folder source 

Follow these steps to add a Folder source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select a Folder, click Next, and a folder tree will be displayed. 

 

2. Specify Folder 

Select the folder from the tree containing the source files you 

want to index, or enter the folder name in the text field above 

the tree. All files in the selected folder will be indexed. When 

the “Include subfolders” checkbox is selected, files in all 
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subfolders (and sub-subfolders, etc.) will also be indexed. When 

the “Include hidden folders and files” checkbox is selected, 

hidden files and folders will be indexed as well. 

Note: Folder trees containing many items may take some time to be 

displayed. Please be patient. 

Click Next to continue. 

The last steps in the definition of a source type are almost the same for all 

types.  They are described in the section “Last steps in a source type 

definition”. 

9.2.2 Adding a MS Outlook file (PST, OST) 

source 

Follow these steps to add an MS Outlook file (PST, OST) source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select "MS Outlook file (PST, OST)" and click Next. 

 

2. Specify File 

Add the filename and location of the PST or OST file you wish 

to investigate: 

Click Open to browse for PST or OST files. 

Select the file you wish to investigate and click Open. 

Click Next to continue. 

Tip:  When you want to index email from an active Outlook installation, you 

can find the PST file in the following directory (folder): 

 

• Windows Vista and Windows 7:  

C:\Users\<username>\AppData\Local\Microsoft\Outlook 

 

• Windows 2000 and XP:  
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C:\Documents and Settings\<username>\Local 

Settings\Application Data\Microsoft\Outlook 

The last steps in the definition of a source type are almost the same for all 

types. They are described in the section “Last steps in a source type 

definition”. 

Intella will try to recover deleted items from the Outlook data file. 

Recovered items will be located in a special folder named 

“<RECOVERED>”. 

9.2.3 Adding an MS Outlook Express file 

(DBX, MBX) source 

Follow these steps to add an MS Outlook Express file (DBX, MBX) source 

to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select "MS Outlook Express file (DBX, MBX)" and click Next. 

 

2. Specify File 

Add the filename and location of the DBX or MBX file you wish 

to investigate. 

Click Open to browse folders for DBX or MBX files. 

Select the file you wish to investigate and click Open. 

Click Next to continue. 

Tip:  If you want to index email from an active Outlook Express installation, 

you can find the DBX file in the following folder... 

 

• Windows 2000 and XP:  

C:\Documents & Settings\<username>\Local 

Settings\Application Data\Identities\{<arbitrary 

string>}\Microsoft\Outlook Express 
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The last steps in the definition of a source type are the same for all types. 

They are described in section “Last steps in a source type definition”. 

9.2.4 Adding a Lotus Notes NSF file source 

Follow these steps to add a Lotus Notes NSF file source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select “Lotus Notes NSF file” and click Next. 

 

2. Specify File 

Add filename and location of the file you wish to investigate. 

Click Open to browse for NSF files. 

Select the file you wish to investigate and click Open. 

Click Next to continue. 

Tip:  If you want to index email from an active Lotus Notes installation, you 

will find the NSF files in the following directory (folder): 

 

• Version 7.x: C:\Program Files\Lotus\Notes\Data 

 

• Version 8.x: C:\Program Files\IBM\Lotus\Notes\Data 

The last steps in the definition of a source type are the same for all types. 

They are described in section “Last steps in a source type definition”. 

9.2.5 Adding an Mbox file source 

Follow these steps to add an Mbox file source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select “Mbox file” and click Next. 
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2. Specify File 

Add filename and location of the Mbox file you wish to 

investigate. 

Click Open to browse folders for Mbox files. 

Select the file you wish to investigate and click Open 

Click Next to continue. 

The last steps in the definition of a source type are the same for all types. 

They are described in section “Last steps in a source type definition”. 

9.2.6 Adding an IMAP account source 

Follow these steps to add an IMAP Account source to Intella: 

1. Source Type 

Start the Add New Source wizard from the Sources menu. 

(Sources > Add New...) 

Select "IMAP account" and click Next. 

 

2. Specify Account 

Enter the settings for the target email account, e.g., “mail.my-

isp.com” with the username and password. Select the “use 

secure connection (SSL)” checkbox if you want or need a secure 

connection to the mail server. This is recommended, because 

without a secure connection your password will be sent as plain 

text. 

Click Next to continue. 

 

3. Select Folders 

In the next step, Intella will contact the specified email server 

to retrieve the mail folder tree. If you selected a secure 

connection and the server uses a certificate that cannot be 

validated automatically, a dialog will appear that asks you 

whether the certificate should be accepted.  Once connected, 

after you accept the certificate if applicable, Intella will display 

the folder tree of the target mail account. You can then select 

the folders that you want to make searchable by placing a check 
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in the box next to the desired folders.  

Click Next to continue. 

Note: If you want to index subfolders, you will need to select them; otherwise 

they will be ignored. The wizard has two convenient buttons for selecting and 

deselecting all folders. 

The last steps in the definition of a source type are the same for all types. 

They are described in section “Last steps in a source type definition”. 

9.2.7 Last steps in a source type definition 

The following final steps are the same for all source type definitions. 

1. Source Name 

In the Source Name sheet you are asked to enter a name for the 

source. The name will be shown in the list of sources in the 

Sources panel and functions as a label for your reference. 

Click Next to continue. 

 

2. Options 

Intella makes the indexing of certain complex file types 

optional. You can disable this to improve indexing performance 

at the cost of fewer results. 

 Select Index mail archives if you want to extract all emails 

and attachments from mail archives like PST and NSF files. 

Subsequent processing of documents and archives found in 

the attachments are still subject to the next two options. 

Note: this option is only shown for Folder sources, with 

the mail sources it is evident that the selected mail archive 

needs to be indexed. 

 Select Index archives if you want Intella to index files 

inside archives such as ZIP and RAR files. 

 Select Index content embedded in documents if you want 

to extract images and other binary items embedded in 

Microsoft Office, OpenOffice and PDF documents. This will 
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make these items separately searchable and viewable. 

Click Next to continue. 

 

3. Completed Source Definition 

Finally, you will be presented with a dialog to inform you that 

you have successfully defined a new source. 

You may optionally start indexing the source. Indexing is 

required to be able to search and explore the items in this 

source. 

Once you click the Finish button, the indexing process will 

proceed according to the options you have selected. 

Tip: Because the active indexing process prevents you from interacting with the 

rest of the program until finished, you may wish to skip this part now (e.g., to 

define more new sources) and index the sources later by clicking the Re-index 

menu item in the Sources menu. 

Note:  At any time except before the step "Completed Source Definition,” you 

can click the Cancel button to return to the Intella interface without having added 

a new source to the case. 

9.3 Indexing and re-indexing 

9.3.1 Indexing 

After defining a source, Intella will index it: it will inspect all items (emails, 

files etc.) that it can find in the source file(s), enabling Intella to return 

instantaneous results during your investigation for relevant evidence. 

Note:  During indexing, you will see a dialog displaying which file is currently being 

processed, as well as some statistics. You will not be able to interact with the rest 

of the program while this dialog is shown. Resizing and minimizing the main 

window remains possible though. 
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The statistics in this dialog reveal the number of items that Intella has 

found in the source(s) that are being indexed, split up in various subtypes. 

Please be aware that the numbers shown in the dialog count both files and 

folders. For example: one folder with two files in it will be counted as three 

items. 

You can abort the index process at any time by clicking the Stop button. 

Intella will finish processing the current item and then lets you close the 

dialog. Note though that there is no way to resume the indexing process, it 

needs to be redone from scratch in a later session using the Re-index 

option. 

9.3.2 Re-indexing 

If you believe that the search results have become corrupt, for any reason, 

or if you had to interrupt an earlier indexing attempt, you can always re-

index all sources. The Re-index option is available in the Sources menu. 

Intella will remove all indexes it has previously created and create a new 

index as it did when the sources were first added. 

The Re-index option can also be used when you opted not to index the 

sources immediately after defining them. This lets you define multiple 

sources and index them in one go. 
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9.4 Editing sources 

To see the configuration of a source, go to Sources > Edit Sources or type 

CTRL+E. A dialog will open that displays the list of sources on the left. 

 

When you click on a source, its details will be shown in the area to the right 

of the list. The name and type are shown as well as source type-specific 

details such as files or folders to index, indexing options, etc. See the 

section on adding sources above for the precise meaning of these settings 

per source type. 

Only the source name is editable, the other options are fixed after source 

definition. 

When you change source names, the Apply button will become enabled. 

Changes will only be applied when you click Apply. If you select a different 

source or click the Close button without first clicking Apply, a dialog will 

appear to prompt you to apply the changes, discard the changes, or cancel 

the operation. 
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9.5 Exceptions report 

An indexing exceptions report can be produced by choosing Sources > 

Exceptions Report. The produces a CSV file that lists all items that had 

issues during indexing. This can range from minor issues such as date 

parsing problems to file corruptions that affect the entire item. 

For every item the following information is listed: 

 The item ID. This can be used to quickly locate  the item in the case 

using View > Preview Item… The Previewer will also show a 

warning icon when displaying such an exception item. 

 The file name, file size and detected file type of the problematic 

item. 

 The location of the problematic item. This includes both the path to 

the containing evidence file (e.g. a PST file) as well as the path 

within that file (e.g. the mail folder and parent email, when the 

exception occurred on an attachment). 

 Information on the parent email if there is any: its item ID, the 

sender, sent date and subject. 

 A warning severity. This can have the following values: 

o “Corrupt file”: this indicates that the file is structurally 

damaged and that no content could be extracted from it. 

Some external tools may be able to repair such files. 

o “Encrypted item”: this indicates that the file is protected 

with a password or other security mechanism. The amount 

of information that still could be extracted is dependent on 

the file type. These items can also be found using the 

Encrypted category in the Features facet. External 

decryption tools may be able to decrypt this item. 

o “Partial extraction”: this indicates that some content 

could be extracted but not all. E.g. part of the metadata 

may be missing, or some embedded items could not be 

extracted. 
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 A warning code that provides additional detail to the warning 

severity, e.g. whether metadata or embedded items were missing in 

case of partial extraction. 

 A warning description. This provides the finest level of detail. This 

message is also contained in the log files. 

When an item has multiple exceptions, it will occupy several rows in the 

CSV. 

All items that produced an exception during indexing can easily be found 

using the Exception Items category in the Features facet. 
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10 Keyword search 

To search for text, enter a query in the Search panel and click the Search 

button. 

For query syntax rules, refer to the “Search query syntax” section below. 

10.1 Search options 

With search options you can limit keyword searching to specific item parts 

or attributes: 

 Text 

 Title / Subject 

 Summary & Description (includes e mail 

headers) 

 Path & File name 

 Authors & E-mail Addresses 

 Message Headers 

 Raw Data (currently includes low-level 

data from PSTs and raw vCard contents) 

 Comments 

To see the search options, click the Options button 

under the search text field. The options box will be 

displayed below the button. 

Select the options for properties that you want to include in your search, 

and deselect those you want to exclude. Your selected search options will be 

stored and used for future searches until you change them. 

Note: As a reminder, the Options button will show a yellow triangle when 

not all options are selected.  
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To hide the options box, click the Options button again. If you have made 

any changes, the icon on the Options button will change to a yellow warning 

sign as a reminder that you have changed options that will affect your 

searches. 

10.2 Search query syntax 

In the text field of the Search panel you can use special query syntax to 

perform complex multi-term queries and use other advanced capabilities. 

Tip:  You can see the list shown below by clicking the question mark button in the 

Search panel. 

10.2.1 Use of multiple terms (AND/OR 

operators) 

By default, a query containing multiple terms matches with items that 

contain all terms anywhere in the item. For example, searching for: 

John Johnson 

returns all items that contain both “John” and “Johnson.” There is no need 

to add an AND (or “&&”) as searches are performed as such already, 

however doing so will not negatively affect your search. 

If you want to find items containing at least one term but not necessarily 

both, use one of the following queries: 

John OR Johnson 

John || Johnson 

10.2.2 Minus sign (NOT operator) 

The NOT operator excludes items that contain the term after NOT: 

John NOT Johnson 

John -Johnson 
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Both queries return items that contain the word “John” and not the word 

“Johnson.” 

John -“John goes home” 

This returns all items with “John” in it, excluding items that contain the 

phrase “John goes home.” 

The NOT operator cannot be used with a single term. For example, the 

following queries will return no results: 

NOT John 

NOT “John Johnson” 

10.2.3 Phrase search 

To search for a certain phrase (a list of words appearing right after each 

other and in that particular order), enter the phrase within full quotes in 

the search field: 

“John goes home” 

would match with the text “John goes home after work” but would not 

match the text “John goes back home after work.” 

10.2.4 Grouping 

You can use parentheses to control how your Boolean queries are 

evaluated: 

(desktop OR server) AND application 

retrieves all items that contain “desktop” and/or “server,” as well as the 

term “application.” 

10.2.5 Single and multiple character wildcard 

searches 

To perform a single character wildcard search you can use the “?” symbol. 

To perform a multiple character wildcard search you can use the “*” 

symbol. 
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To search for “next” or “nest,” use: 

ne?t 

To search for “text”, “texts” or “texting” use: 

text* 

The “?” wildcard matches with exactly one character. The “*” wildcard 

matches zero or more characters. 

10.2.6 Fuzzy search 

Intella supports fuzzy queries, i.e., queries that roughly match the entered 

terms. For a fuzzy search, you use the tilde (“~”) symbol at the end of a 

single term: 

roam~ 

returns items containing terms like “foam,” “roams,” “room,” etc. 

The required similarity can be controlled with an optional numeric 

parameter. The value is between 0 and 1, with a value closer to 1 resulting in 

only terms with a higher similarity matching the specified term. The 

parameter is specified like this: 

roam~0.8 

The default value of this parameter is 0.5. 

10.2.7 Proximity search 

Intella supports finding items based on words that are within a specified 

maximum distance from each other in the items text. This can be seen as a 

generalization of a phrase search. 

To do a proximity search you place a tilde (“~”) symbol at the end of a 

phrase, followed by the maximum word distance: 

“desktop application”~10 

returns items with these two words in it at a maximum of 10 words 

distance. 
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The words do not necessarily have to be in this order, but the order does 

influence the evaluation of the query. In this example, when the word 

"application" appears before "desktop" in the document, there can only be 

eight words in between to make the match. This is because the second word 

first has to shift two positions to get to a position before the first term and 

these shifts are also taken into account when calculating the word distance. 

10.2.8 Field-specific search 

Intella's Keyword Search searches in document texts, titles, paths, etc. By 

default, all these types of text are searched through. You can override this 

globally by deselecting some of the fields in the Options, or for an 

individual search by entering the field name in your search. 

title:intella 

returns all items that contain the word “intella” in their title. 

The following field names are available: 

 text - searches in the item text 

 title - searches in titles and subjects 

 path - searches in file and folder names 

 summary - searches in descriptions, metadata keywords, etc. 

 agent – searches in authors, contributors and email senders and 

receivers 

 headers - searches in the raw email headers 

 rawdata - searches in raw document metadata 

 comment - searches in all comments made by reviewer(s) 

You can mix the use of various fields in a single query: 

intella agent:john 

searches for all items containing the word “intella” (in one of the fields 

selected in the Options) that have “john” in their author metadata or email 

senders and receivers. 
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11 Using facets 

Besides keyword searching, the indexed items can be 

browsed by facets, which represent specific item 

properties. 

Every facet organizes the items into groups (possibly 

hierarchical) depending on a specific item property. 

Selecting a facet in the Facet panel will give you a list of 

all values of the selected facet in the lower part of the 

panel. In the example on the right, the Type facet has a 

list of file types as values. 

To search for items that match with a facet value, select 

the facet value and click the Search button. 

Tip: To export facet information, (1) select a facet, (2) open 

the context menu - right mouse click - on the facet values, 

and (3) select Export values…. 

This will open the Export values dialog. Choose a file name 

and folder and save the export file. The CSV file will contain 

the facet values (e.g. file types, email addresses, folder names), 

their total counts in the case, and their currently shown 

counts, which represents the overlap with the currently 

shown search results. 

11.1 Available facets 

11.1.1 Saved Searches 

The Saved Searches is a list of previous sets of searches that the user has 

stored. 
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When search results are displayed on in the Cluster 

Map and the Searches list, the Save button beneath the 

Searches list will be enabled. When the user clicks this 

button, a dialog opens that lets the user enter a name 

for the saved search. A default name will be suggested 

based on the current searches. After clicking on the OK 

button, the chosen name will appear in the list in the 

Saved Searches facet. 

Click on the name of the saved search and then on the Restore button to 

bring the Cluster Map and the Searches list back into the state it had when 

the Save option was used. 

11.1.2 Features 

The Features facet allows you to identify items that fall in certain special 

purpose categories: 

 Encrypted: all items that are encrypted. Example: password-

protected PDF documents. If you select Encrypted and click the 

search button, you will be shown all items that are encrypted. 

Note: Intella detects password-protected PDF files, but before flagging 

them as Encrypted it tries to "decrypt" them with an empty password. 

This works surprisingly often. If decryption succeeds with this password, 

the file is not flagged as Encrypted by Intella because its contents are 

readable and searchable. Also know that PDF file protection is a very 

elaborate mechanism, i.e. actions like text extraction, copying, viewing 

can all be protected separately. Therefore it may be the case that text 

extraction is allowed in the PDF file's security settings, yet Adobe 

Acrobat still asks the user for a password when e.g. printing the PDF. 

Only when text extraction is disallowed will Intella flag the file as 

Encrypted. 

 

Note: Sometimes files inside an encrypted ZIP file are visible without 

entering a password, but a password still needs to be entered to extract 

the file. Such files cannot be exported with Intella. However, in this case 
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both the ZIP file and its encrypted entries will be marked as Encrypted, 

so searching for all encrypted items and exporting those will capture the 

parent ZIP file. 

 Unread: all emails that are marked as "unread" in the source file 

(PST/OST only). Note that this status is not related to previewing 

in Intella. 

 Empty document: all items that have no text while text was 

expected. Example: a PDF file with only images. 

 Has Duplicates: all items that have a copy in the same source, i.e. 

an item with the same MD5 or message hash. 

 Tagged: all items that are tagged. 

 Flagged: all items that are flagged. 

 Commented: all items that have a comment. 

 Previewed: all items that have been opened in Intella’s previewer. 

 Opened: all items that have been opened in their native 

application. 

 Exported: all items that have been exported. 

Note: In cases in which multiple users have worked, i.e. shared cases or cases 

with imported Work Reports, the Previewed, Opened, Exported, Commented, 

Tagged and Flagged nodes shown in the Facet panel will have sub-nodes, one node 

for each user. 

11.1.3 Tags 

Tags are labels defined by the user to group individual items. Typically used 

tags in an example are for example “relevant”, “not relevant” and “legally 

privileged”. 

Tags are added to items by right-clicking in the Results table or the Cluster 

Map and choosing the Add Tags… option. Tags can also be added in the 

Previewer. The exact procedure is described in other sections of this 

manual. 

To search for all items with a certain tag, select the tag from the Tags list 

and click the Search button below the list. 
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When tags have been added by different users in the same case, the tag 

node will have sub-nodes for each individual user. These sub-nodes can be 

used to search for all items that have been tagged with that tag by that user. 

11.1.4 Location 

This facet represents the folder structure inside your sources. 

Select a folder and click Search to find all items in that folder. 

When “Search subfolders” is selected, the selected folder, all 

items in that folder, and all items nested in subfolders will be 

returned, i.e. all items in that entire sub-tree. 

When “Search subfolders” is not selected, only the items nested 

in that folder will be returned. Items nested in subfolders will not 

be returned, nor will the selected folder itself be returned. 

When your case consists of a single indexed folder, then the 

Location tree will show a single root representing this folder. 

Selecting this root node and clicking Search with “Search 

subfolders” switched on will therefore return all items in your 

case. 

When your case consists of multiple mail files that have been 

added separately, e.g. by using the PST and NSF source types in 

the New Source wizard, then each of these files will be 

represented by a separate top-level node in the Location tree. 

11.1.5 Email Address 

This facet represents the names of persons involved in sending and 

receiving emails. The names are grouped in seven categories: 

 From 

 Sender 

 To 

 Cc 

 Bcc 

 All Senders (From, Sender) 
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 All Receivers (To, Cc, Bcc) 

Most emails typically only have a From header, not a Sender. The Sender 

header is often used in the context of mailing lists. When a list server 

forwards a mail sent to a mailing list to all subscribers of that mailing list, 

the message send out to the subscribers usually has a From header 

representing the conceptual sender (the author of the message) and a 

Sender header representing the list server sending the message to the 

subscriber on behalf of the author. 

11.1.6 Phone Number 

This facet lists phone numbers observed in phone calls from cellphone 

reports as well as phone numbers listed in PST contacts and vCard files. 

The “incoming” and “outgoing” branches are specific to phone calls. The 

“All Phone Numbers” branch combines all of the above contexts. 

11.1.7 Date 

This facet lets the user search on date ranges by entering a From and To 

date. Please note that the date entered in the To field is considered part of 

the date range. 

Besides start and end dates, Intella lets the user control which date 

attribute(s) are used: 

 Sent (all email items) 

 Received (all email items) 

 File Last Modified (file items) 

 Content Created (file items and email items from PST files) 

 Content Last Modified (file items and email items from PST files) 

 Called (phone calls) 

Click the Search button to find items created or modified in the date range 

that you specified. The result set will be added to the details panel. 

Note that the Preferences dialog has a setting that controls how dates are 

displayed: by selecting a geographic region, all dates will be displayed in a 

manner commonly used in that region. 
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11.1.8 Type 

This facet represents the file types (Microsoft Word, PDF, JPEG, etc.), 

organized into categories like Documents, Spreadsheets, etc. To refine your 

query with a specific file type, select a type from the list and click “Search”. 

Note that you can search for both specific document types like PNG Images, 

but also for the entire Image category. 

11.1.9 Author 

This facet represents the name(s) of the person(s) involved in the creation 

of documents. The names are grouped into two categories: 

 Creator 

 Contributor 

To refine your query by a specific creator or contributor name, select the 

name and click the Search button. 

11.1.10 Keyword Lists 

In the Keyword List facet you can load keyword list, to automate the 

searching with sets of previously determined search terms.  

A keyword list is a text file in UTF-8 encoding that contains one search 

term per line. Note that a search term can also be a combination of search 

terms, like “Paris AND Lyon”. 

Once loaded, all the search terms (or queries) found in the keyword list are 

shown in the “Queries” panel in the Keyword Lists facet. They are now 

available for search. 

When the 'Combine queries' checkbox is selected, multiple terms selected 

in the 'Queries' panel will be combined to search for items matching any of 

the selected terms (Boolean OR operator). The items will be returned as a 

single set of results (one cluster).  If the checkbox is not selected, the 

selected terms will be searched separately, resulting in as many result sets 

as there are selected queries in the list. 

Tip: Keyword lists can be used to share search terms between investigators. 
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11.1.11 MD5 and Message Hash 

Intella can calculate MD5 and message hashes to check the uniqueness of 

files and messages. If two files have the same MD5 hash, Intella considers 

them to be duplicates. Similarly, two emails with the same message hash 

are considered to be duplicates. With the MD5 and Message Hash facet you 

can: 

1. Find items with a specific MD5 or message hash and 

2. Find items that match with a list of MD5 and message hashes. 

Specific MD5 or message hash 

You can use Intella to search for files that have a specific MD5 or message 

hash. To do so, enter the hash (32 hexadecimal digits) in the field and click 

the Search button. 

List of MD5 or message hashes 

The hash list feature allows you to search the entire case for MD5 and 

message hash values from an imported list. Create a text file (.txt) with one 

hash value per line. Use the Add… button in the MD5 Hash facet to add the 

list. Select the imported text file in the panel and click the Search button 

below the panel. The items that match with the MD5 or message hashes in 

the imported list will be returned as a single set of results (one cluster).  

Tip:  Install a free tool such as MD5 Calculator by BullZip to calculate the MD5 

hash of a file. You can then search for this calculated hash in Intella to determine if 

duplicate files have been indexed. 

Tip: Use the “Export table as CSV” option in the Details table to export all MD5 

and message hashes of a selected set of results to a CSV file. 

11.1.12 Language 

This facet shows a list of languages that are automatically detected in your 

items. 

To refine your query with a specific language, select the language from the 

list and click the Search button. 
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Important: If Intella cannot determine the language of an item, e.g. because the 

text is too short or mixes multiple languages, then the item will be classified as 

“Unidentified”. 

When language detection is not applicable to the item’s file type, e.g. images, then 

the item is classified as “Not Applicable”. 

11.1.13 Size  

This facet groups items based on their byte size. 

To refine your query with a specific size range, select a value from the list 

and click the Search button. 

11.1.14 Duration 

This facet reflects the duration of phone calls listed in a cellphone report, 

grouped into meaningful categories. 

11.2 Including and excluding 

facet values 

11.2.1 Including a facet value 

Facet values can be included and excluded. Including a facet value means 

that only those search results will be shown that match with the included 

facet value. 

Example: The user enters the facet value “PDF Document” and includes 

this facet value with the dropdown menu on the Search button of the facets 

panel. The selections panel in the Cluster Map shows that “PDF Document” 

is an included term. This means that from now only clusters will be shown 

with items that are PDF Documents. 

11.2.2 Excluding a facet value 

Excluding a facet value means that only those search results will be shown 

that do not match with the excluded facet value. 
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Example: The user enters the facet value “PDF Document” and excludes 

this facet value with the dropdown menu on the Search button of the facets 

panel. The selections panel in the Cluster Map shows that “PDF Document” 

is excluded. As long as this exclusion remains, only clusters with items that 

are not PDF Documents will be shown. 

Note:  Excludes are often used to filter out privileged items before exporting 

a set of items, e.g. by tagging items that match the privilege criteria with a tag 

called “privileged”. 

In this scenario it is important to realize that when exporting an email to e.g. 

Original Format or PST format, it is exported with all its attachments embedded 

in it. The same applies to a Word document: it is exported intact, i.e. with all 

embedded items. Therefore, when an attachment is tagged as “privileged” and 

“privileged” is excluded from all results, but the email holding the attachment is in 

the set of items to export, the privileged attachment will still end up in the 

exported items. 

The solution is to also tag both the parent email and its attachment as 

“privileged”. The tagging preferences can be configured so that all parent items 

and the items nested in them automatically inherit a tag when a tag is applied to a 

set of items. 

 

When filtering privileged information with the intent to export the remaining 

information, we recommend that you verify the results by indexing the exported 

results as a separate case and checking that there are no items matching your 

criteria for privileged items. 
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12 Cluster Map panel 

The Cluster Map shows search results in a graphical format. Since 

the Cluster Map is a new way of presenting search results, this 

chapter will help you to understand how it works. 

 

 

12.1 Understanding a Cluster Map 

The figure above shows labels, clusters and items. The larger spheres are 

clusters. They represent groups of items. Clusters contain smaller spheres 

that represent individual items, such as emails and files. Parts of the 

query, shown as labels, organize the map. Every cluster is connected to 

one or more labels. 

The figure above shows the Cluster Map after the user has evaluated a 

query with two parts: a keyword search for the term “application” and a 

search for Documents using the Type facet. 

The Cluster Map holds two result sets, with the following labels: 
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 “see”: 501 items, red edges 

 “look”: 124 items, blue edges 

The colored edges rendered in the background connect items to labels, 

indicating that these items belong to that result set. An item contained in 

multiple result sets is displayed only once but connected to the labels of the 

sets that contain it. Example: the items in the middle cluster. 

Note:  When a cluster contains more than 250 items, it is displayed as a single 

sphere labeled with the number of items. The individual items are hidden.  This 

prevents clusters with large number of items from disturbing the usability of the 

Cluster Map. 

12.2 Working with Cluster Maps 

12.2.1 Removing result sets 

The result sets created with the current query are listed in 

the box at the top right corner of the Cluster Map panel. To 

remove a result set from the Cluster Map, click on the 

remove icon (red X) in the list. 

To clear the Cluster Map - remove all result sets - and start 

a new search, click the Clear button in the terms list. 

If the Cluster Map regeneration takes too long, you can stop 

the process by clicking the Stop button. 

12.2.2 Opening a search result 

Results can be opened in the viewer by double-clicking on their spheres in 

the graph. Results can also be opened in the Details panel by double-

clicking on the row in table view, or by clicking on the title in list view. 

Tip:  Details about individual results are shown in a tool tip that pops up when the 

mouse cursor is hovered over an item in a cluster. 
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12.2.3 Export cluster map 

You can export the current Cluster Map graph as a transparent, 24-bit PNG 

image. To do this, choose the “Cluster Map…” option in the Export menu. 

12.3 Options 

The Cluster Map options and settings can be accessed through the buttons 

in the Cluster Map toolbar. 

 Display individual results / Display clusters as single 

visual entities 

These two buttons switch between two modes of cluster 

visualization. In the first mode, each individual item is shown as an 

individual visible item within a cluster. Placing the mouse cursor 

above this item will show information about the item in a tool tip. If 

you do not need this much detail in the graph, you can use the 

second mode, in which individual items are not displayed within 

the clusters. When you click on a cluster, the detailed information 

is shown in the Details Panel. 

 

 Change color scheme 

This button opens a menu to choose a scheme to colorize the 

clusters in the map. There are three color schemes: 

o Result Based Colors (default): in which each query result 

set has its own color. 

o Rank Based Colors: in which the result set that matches the 

most queries has the darkest color. The less it matches, the 

lighter the color. 

o Uniform Colors: where all results have the same color, until 

you make a selection, then the selections takes on a darker 

color. 

 

 Hide less connected clusters 
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If this option is enabled, the clusters with fewer connections will be 

hidden. 

 

 Scale the graph to fit the available screen space 

If this option is enabled, the cluster map size will be automatically 

adjusted for the screen space of the panel (no scrollbars will 

appear). This option can also be accessed through View > Cluster 

Map > Scale to fit window. 



Page 139| Intella™ User Manual | © 2012 Vound, LLC 

13 Details panel 

In order to inspect the contents of the visualization, the user can select a 

cluster or result set by clicking on it. Its contents will be displayed in the 

“Details” panel below the map. This panel contains a list of the items that 

can be presented in four modes: 

 Table view 

 List view 

 Thumbnails view 

 Timeline view 

Note: Switching display mode is done by clicking the “Display results XXX” 

buttons. With the Display results in a table button you can switch to the table 

view of the results list. Display results in a list shows a list with five results per 

page (configurable in the Preferences panel: File > Preferences). With the Display 

results as thumbnails button you will switch to the thumbnail view. With the 

Display results in a timeline button you will switch to the timeline view. 

13.1 Table view 
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The table view displays the results as a table in which each row represents a 

single item and the columns represent the attributes such as title, date, 

location etc.  

The set of attributes to display can be customized with “Toggle visible table 

columns” button - the right button of the Details Panel Control.  

Click on a table column header to sort the table by specific item attributes. 

13.1.1 Adding and removing columns 

With the “Toggle visible table columns” button in the Details toolbar you 

can add and remove columns in the table, by (de)selecting column names in 

the popup that shows when you click the button. The selected columns are 

stored: every time you start Intella these columns will be shown until you 

select other columns. 

This option is only available in the Table view. The following columns are 

available: 

General columns: 

 Contact name: the name of a contact encountered in a PST file or 

as a vCard file. 
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 Duplicates: Shows the number of duplicates of an item within the 

case. 

 Encrypted: Shows if an item is encrypted. 

 Exception: Shows if an item had one or more issues indexing 

properly. 

 File Name: The name of a file in the file system, in an archive or 

used as an attachment name. 

 Item ID: The ID used internally in Intella’s database to refer to 

this item. 

 Language: The language of the item's text. The language field is 

left blank when the language cannot be detected automatically. 

When the language could not be determined, e.g. because the text is 

too short or mixes various languages, the value shown will be 

“unidentified”. Item types that inherently do not have a language, 

e.g. images or archives, show the “not applicable” value. 

 Location: Name of the location in the original evidence data 

where the item is stored. For example, an email in a PST file would 

have a location that would start with the folder and file name of the 

PST file, followed by the mail folder path inside that PST file. 

 MIME type: The type of an item according to the MIME standard. 

 Size: The item's size in bytes. 

 Source: The name of the Intella source that holds the item. 

Typically this is the root folder name or the name of the mail 

container file (e.g. PST or NSF file). 

 Source Path: The path to the evidence, e.g. the PST or NSF file, or 

the root folder of a Folder source. This helps reviewing items when 

dealing with a lot of evidence files – the name of the evidence file 

and the derived source name may not hold enough information to 

easily discern the origin of the information. 

 Subject: The subject of an email or document item – note that 

some document formats can have both a title and a subject. 

 Title: The title of a document item. 

 Type: The item's human-readable type, e.g. “MS PowerPoint 

Document” or “Email Message.” 
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 URI: Uniform Resource Identifier, the identifier used internally by 

Intella for the item in addition to the Item ID. 

Email-specific columns: 

 Attachments: Shows the file names of an email’s attachments. 

 Has Attachments: Emails that are marked as having 

attachments. 

 Message Hash: Shows the Message Hash for email messages. 

This hash is used for deduplicate emails in a manner that works 

across different mail formats. 

 Message ID: Shows the Message ID extracted from email 

messages. 

 Receiver: The name and email address of the receiver(s) of an 

email item. 

 Sender: The name and email address of the sender(s) of an email 

item. 

 Unread: Shows if an email item was unread at the time of 

indexing. 

Cellphone-specific columns: 

 All Phone Numbers: phone numbers relevant to a phone call, 

regardless of whether it is an incoming or outgoing call, combined 

with phone numbers found in contacts. 

 Incoming Phone Numbers: phone numbers used for incoming 

phone calls. 

 Outgoing Phone Numbers: phone numbers used for outgoing 

phone calls. 

 Duration: how long the phone call took. 

File- and document-specific columns: 

 Contributor: The name(s) of the contributor(s) of a document. 

These are typically authors that edited exiting documents. 

 Creator: The name(s) of the creator(s) of a document item. These 

are typically the initial authors of a document. 
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 Empty document: Shows that the item has no text while text was 

expected. Example: a PDF file that contains only images. 

 MD5 Hash: The MD5 hash that uniquely identifies the item. 

Columns containing dates: 

 Called: the date a phone call was made. 

 Content Created: Shows the date that the content was created. 

 Content Last Modified: Shows the date that the content of the 

item was last modified, according to the document-internal last 

modified date. 

 File Last Modified: Shows the date of the last time the file was 

modified, according to the file system. 

 Received: The date the item was received. 

 Sent: The date the item was sent. 

Review-specific columns: 

 Comments: Shows if an item has comments. When this is the 

case, a yellow note icon is shown in the table. Hover over the icon 

to see a tooltip with the comments attached to the item. 

 Exported: Shows if an item has been exported. 

 Flagged: Shows a column at the left side of the table that indicates 

if an item is flagged. Click the checkbox if you want to flag an item. 

 Opened: Shows if an item has been opened in its native 

application. 

 Previewed: Shows if an item has been opened in the previewer. 

 Tags: Shows the tags connected to an item. 

For contacts, e.g. email senders and receivers, this popup lets the user 

choose whether to display the contact name, the email address or both. The 

chosen setting will affect the table sorting when the involved columns are 

used to sort the table. 

Use the “Check / uncheck all” checkbox to immediately set all checkboxes 

on or off. 
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13.1.2 Reorganizing table columns 

The columns can be reorganized by dragging a column header to a different 

location in the table. The order is persistent across application sessions, but 

specific to that case. 

13.1.3 Sorting the list 

By clicking on a column header, the search results will be sorted 

alphabetically, numerically, or chronologically, depending on the type of 

information shown in that column. By clicking the header once more, the 

sort order will be reversed. Clicking one more time will remove the sorting, 

letting the results be displayed in their original order. 

With the “Sort table” button you can extend the sorting setup.  This feature 

allows you to add multiple sort levels, which means that if the first column 

is not met, sorting will be based on the second (third, fourth, etc.) column 

selected.  You can also specify the sort order per column by select ascending 

(A-Z) or descending (Z-A) order. This dialog lets you use all of the columns 

available, regardless of whether the column is currently present in the table. 

Sorting by multiple columns can also be achieved by holding the Ctrl button 

while you click on column names. Any additional column will be added to 

the list of sorting criterions. 

13.1.4 Deduplicating results 

With the “Deduplicate results” button, duplicates are removed from the 

search results list based on the MD5 hashes of the results. The text next to 

the button informs you if duplicates are removed and how many duplicates 

are removed, if applicable. 

Note:  This option is only available in table view. 

13.1.5 Showing a conversation 

Right-clicking an email item and selecting the “Show conversation” option 

will display a new result set in the Cluster Map -- its label starting with 
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“Conv: ....”-- showing all e mail items that are part of the conversation, 

including replies and forwarded messages. 

Note:  This option is only available in table view. 

13.1.6 Showing the child items 

To determine all items nested in an item, right-click on the item and select 

Preview. Next, switch to the Tree tab to see the full hierarchy, including all 

child items. 

To determine the children of a set of selected items, select all relevant items 

in the Details table, right-click on one of them and click the “Show children” 

option. This will open a dialog that asks you what children to put in the 

result set, as child items may also again contain child items. 

Note:  This option is only available in table and thumbnails view. 

13.1.7 Showing the parent items 

Right-click an email attachment and select the option “Preview parent 

email” to view the email message that contains the selected item. This 

feature looks up the parent item recursively until it reaches an email item. 

Note:  This option is only available in table and thumbnails view. 

To determine the parent of a set of selected items, select all relevant items 

in the Details table, right-click on one of them and click the “Show parents” 

option. This will open a dialog that asks you what parents to produce, as 

there may be multiple parents in the path. 

13.2 List view 

List view displays the results in a form similar to conventional web search 

engines (select the third button in the Details Panel Control). For each item, 

the title and other important metadata will be displayed. 

For your convenience, the list is split into separate pages. 



Page 146| Intella™ User Manual | © 2012 Vound, LLC 

 

13.3 Thumbnails view 

The Thumbnails view displays the thumbnails of the images detected within 

a selected cluster. This includes images embedded in email attachments 

and images inside documents. 

 

Hover over the thumbnails with your mouse cursor to see a summary of the 

data connected to the image. You can flag an image with the checkbox 

below the thumbnail. 

When you double-click a thumbnail, the image will open in the previewer. 
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13.4 Timeline view 

The Timeline view shows a 

chronological representation 

of email communications. 

The left pane shows the 

email senders and receivers, 

with their communication 

plotted chronologically. 

Every arrow in the timeline 

view is an email and points 

to the receiver of the email. 

The green squares are senders. The red squares are receivers on the To-list. 

The blue squares are receivers on the CC-list. Cyan squares are receivers on 

the BCC list. 

Tip: When you click an arrow, the arrow, the connected arrows, and the 

connected squares will be highlighted. When you double click an arrow, the email 

will show in a preview window. 

 

Tip: Export a timeline by choosing Export > Timeline… from the menu. The 

timeline will be saved as a PNG image. 
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14 Tagging 

Tagging is the process where you connect a descriptive word to an item or a 

group of items. For example: One of your items is a PDF document that 

contains valuable information. You decide to tag the item with the word 

“important.” Tagging helps you to organize results, for example by 

separating important and unimportant information. 

Tagging can be done in several ways in Intella. This chapter gives you an 

overview of the possibilities: 

 Tagging in the main window 

 Tagging in the previewer 

 Letting other items inherit tags automatically 

 Pin a tag to a button 

 See all tagged items 

 Searching with tags 

 Deleting a tag 

14.1 Tagging in the main window 

14.1.1 Adding tags 

To add tags: 

1. Select one or more items from the table, the thumbnail view or 

the timeline. 

 

2. Open the context menu (right mouse click), and select 

“Add tags…” 

 

3. In the “Add tags to x items” dialog you can select already 

defined tags, or define a new tag with optional description. 

When you click OK, the marked tags will be linked to the 

selected items. 



Page 149| Intella™ User Manual | © 2012 Vound, LLC 

The Add Tags menu option is also available in the Cluster Map. Right-click 

on a cluster or label to open a popup menu with this and other options. 

 

 

 

 

14.1.2 Removing tags 

The Remote Tags dialog is used to remove tags from a selected 

items: 

1. Select the items from which you want to remove 

the tags in the table, timeline, thumbnail view, or 

cluster map panel. 

 

2. Open the context menu (right mouse click), and 

Defined Tags shows a 

list of tags. Select a tag 

name to tag items. 
New Tag 

Define new tag with a 

name and an optional 

description. 

 

Override tag preferences 

Use this checkbox to 

temporarily override the 

settings for tag inheritance as 

set in the Tagging Preferences. 
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select the Remove tags… menu option. 

 

3. In the Remove tags from x items dialog select the tags that you 

want to remove, and click OK. 

 

Now the tags are no longer connected to the items. 

14.2 Tagging in the previewer 

If you want to tag or remove a tag in the previewer, please take the 

following steps: 

1. Open the previewer and select the Review tab 

 

2. Click the Tag button to open the tag space 

 

3. Enter a new tag or select an existing tag. To remove a tag (to 

remove the connection between an item and a tag) just deselect 

the tag from the list. 

Three, six or nine tags can be shown as button in the previewer. When a tag 

is listed as a button, clicking the button results in the tag being assigned to 
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the current item. You can set the desired amount of these quick-tag buttons 

in the File > Preferences > Results tab > Previewer section. 

You can also use Ctrl+1, Ctrl+2, Ctrl+3, etc. to quick-tag an item. The 

numbers correspond with the button positions. 

When the 'Auto Advance' toggle button is selected, the previewer will 

automatically switch to the next item in the list. 

14.3 Automatic tag inheritance 

When tagging items, the policy of your investigation may be that some 

related items should be tagged as well. One use case is when tagging items 

as irrelevant: all nested items may then be considered as irrelevant as well. 

Another use is tagging items as privileged; depending on your policy, this 

may then be extended to all other items within the same mail as well. 

Intella offers mechanisms that let these additional tags to be set 

automatically. For more information, see section 18.4. 

14.4 Pin a tag to a button 

In File > Preferences > Tagging tab > Previewer section you can 

select the number of quick tag buttons: three, six or nine. The 

default value is three quick tag buttons. 

You can pin a tag to a button and keyboard shortcut (Ctrl+1, Ctrl+2, Ctrl+3) 

with the following steps: 

1. Select Tags in the facet panel 

 

2. Right click on a tag in the list to open the context menu. 

 

3. Select “Pin tag to button” and select a number from the 

submenu. 

Now you can use the buttons in the previewer and the keyboard shortcuts 

to tag an item. 
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Tags that are pinned to a button are marked with a small blue pin in both 

the Tag facet and previewer. 

Note: To unpin a tag from a button, select 'Unpin tag' in the context menu of 

Tags. 

14.5 See all tagged items 

To get an overview of all items that are tagged in your case, please take the 

following steps: 

1. Select Features in the facet panel. 

 

2. Select Tagged from the list and click Search 

Now you can see all the items that have a tag in the Cluster Map panel. 

14.6 Searching with tags 

To search with tags, please take the following steps: 

1. Select Tags in the facet panel. 

 

2. Select a tag and click Search 

Now you can see the items that have the selected tag in the Cluster Map 

panel. 

14.7 Deleting a tag 

To delete a tag from your case, please take the following steps: 

1. Select Tags in the facet panel. 

 

2. Right click on a tag in the list. 

 

3. Select “Delete” and confirm. 

Now this tag is no longer in your case.  
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14.8 Undo tags 

Besides the Delete option in the Tags facet and the Remove Tags menu item 

in the main window, there is a third way to remove tags from a case: the 

Undo Actions menu. It can be reached by clicking File > Undo Actions… in 

the menu bar. 

The Undo Actions provides a history of all tagging, flagging and 

commenting actions done by all users. In case of tags, it displays the date 

and time of tagging, the tag used and the amount of items that were tagged: 

 

A typical use case is when several tags have been used for tagging sets of 

items and one of these tagging actions was a mistake. Removing the tag 

from only some of its items through table row selection and the Remote 

Tags window would be time-consuming and error-prone. The Delete Tag 

option would eliminate all correct taggings. The Undo Actions then 

provides the option to undo that one mistake and leave the rest intact. 
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15 Exporting 

Intella supports a number of exporting formats, each focusing on a different 

use case. 

15.1 Exporting a single result 

 

A single result can be exported by right-clicking on a row in the Details 

table (or on the item in any of the other views) and selecting “Export…” in 

the content menu. Alternatively, select an item by clicking on it and choose 

Export > Result… in the menu bar. 

A file chooser will open that lets you specify the folder and file name. Click 

“Save” to export the result to that file. The mouse cursor will show a “busy” 

icon while the exporting is taking place. 

The result will be saved in its original format, i.e. a Word document 

attached to a mail gets saved as a Word file. All mails from mail sources 

(PST/OST/NSF/DBX/MBX/Mbox files and IMAP servers) are exported as 

EML files. Evidence files that are already in EML, EMLX or MSG format as 

exported as such. Contacts will be stored in vCard format. 
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Exporting of a single result may take some time as the original mail 

container (e.g. a PST file) has to be opened and the mail or attachment has 

to be located. 

15.2 Exporting a list of results 

 

 

 

 

 

Exporting a collection of documents: 

 Selecting items to export: 

The folder where the 
exported files will be 
stored. 

Export results in one or 

more formats. 

Selecting a format type 
shows the format-specific 
configuration options 

beneath the checkbox. 

 

An export report lists the 

exported items with their 
paths and any error 
messages that may have 
occurred during exporting. 

Specify how exported 
files should be named. 

 

Use export templates to 
store the current export 

configuration under a 
user-defined name. 
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o From the Details Pane, click the Shift and Ctrl keys at the 

same time to select all items in the Details Pane or right 

click and chose “Select All” to select all items. 

 Open the Export Menu Dialog 

o Right click in the Details Pane where all of the items have 

been highlighted OR 

o From the Main Menu, select Export, then select Results 

List. 

This dialog lets you choose the export formats and further configuration 

options. When you click on the checkbox of a specific export format, all 

options for that format will unfold beneath the checkbox. 

15.2.1 Exporting to original format 

The “original format” option exports a file into 

its original format, i.e. a Word document 

attached to a mail gets saved as a Word file. 

All emails from mail sources 

(PST/OST/NSF/DBX/MBX/Mbox files and IMAP servers) are exported as 

EML files. Evidence files that are already in EML, EMLX or MSG format 

are exported as such. 

Select the option "Keep location structure" to preserve the original folder 

structure during the export. A folder will be created for every source, in 

which the original folder structure of that source (as shown in the Location 

facet) will be recreated. 

The original format exported files can be opened with the program that 

your system has associated with that file extension. 
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15.2.2 Export to PDF 

Select the PDF format to create PDF 

documents containing the contents of the 

items you selected. 

You can choose to export to individual PDF 

files, one for every selected item, or to 

export all items into one single 

concatenated PDF file. 

When exporting to individual PDF files, 

select the "Keep location structure" option 

to preserve the original folder structure 

during the export. 

When exporting to a concatenated PDF, the 

resulting PDF can optionally be split in 

chunks of a given size. This is 

recommended for performance and 

stability reasons. 

For all types of items, you can indicate whether to include the properties, 

raw data and comments.  

The properties include typical metadata attributes such as titles, authors, all 

dates, hashes, sizes, etc. 

The raw data currently applies only to emails in PSTs and vCard files. For 

PSTs the low-level information obtained from the PST is listed here. For 

vCards the actual content of the file is listed. In both cases these may reveal 

properties that Intella does not recognize and are therefore not to be found 

in the Properties section. 

The comments refer to the ones made by Intella user(s) in the Comments 

tab in the Previewer.  They are not to be confused with comments that can 

be made in, for example, a Word document. These are part of the Properties 

section. Note that the reviewer comments may include sensitive 

information such as evidence file names, investigator insights, etc.   
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When exporting to PDF and Original Format simultaneously, the “Link 

PDF to original format file” option becomes enabled. When selected, each 

PDF(s) will contain link(s) to the file representing the item in original 

format. 

For emails, the following information can optionally be included: 

 The message body. 

 The full email headers. 

 A list of all attachments. The file name, type and size of each 

attachment will be mentioned. 

 The actual contents of those attachments. The original view 

(described below) will always be selected by default, with the 

extracted text used as a fall-back. 

Note that for emails, a simple header block with the most important 

information like senders, receivers, subject and date will always be 

included. It is not necessary to check the Properties or Headers for that. 

For loose files and attachments that are not emails, the following options 

are available: 

 Include the file’s content. By default, the original view is used, i.e. a 

Word document is rendered as Word would render it, and the 

extracted text is only used when the original view cannot be made, 

e.g. because the file format is not supported. Alternatively, you can 

configure exporting to always use the original view, always use the 

extracted view, or both. 

 List all embedded items, e.g. images found in the document. 

The following file formats can be exported in their original view: 

 MS Office (doc, docx, xls, xlsx, ppt, pptx) 

 Open Office (Writer, Calc, Impress) 

 WordPerfect 

 RTF 

 HTML 

 PDF 
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Note: To export most of these formats in their original form, a local installation 

of MS Office 2010, or an MS Office 2007 installation with the “Save as PDF” add-

in, is required. 

 

We strongly recommend that you do not use any MS Office applications until 

exporting to PDF has completed. Using these applications during exporting can 

result in these applications exiting suddenly and without warning, risking data loss 

on any opened documents. 

15.2.3 Export to PST 

You can export selected emails to a PST file. The main purpose of this 

option is to use the PST file as a carrier for transport of emails. The receiver 

can open the PST file in Microsoft Outlook to see the exported emails. 

Select the “MS Outlook PST file” option and enter a file name for the PST. 

Enter a display and folder name. After opening the exported PST file in MS 

Outlook you will see the names you entered. They help you to locate the 

PST file and its contents in MS Outlook. 

Select the option "Keep location structure" 

to preserve the original folder structure 

during the export. 

The resulting file can optionally be split into 

chunks of a given size. This is highly 

recommended for larger result sets that 

would make the PST grow beyond the 

default suggested file size, as Outlook may 

become unstable with very large PST files. 

The produced files will have a file size that 

is close to the specified maximum file size 

(usually smaller). The export report will list 

for every item to which PST it was added. 

How to export non-email items to a PST file? 

Suppose you have a set of results that you want to export, consisting of 
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emails and other types of results. By exporting this set to a PST file, you 

would not get the non-email items such as attached PDF files and MS Word 

documents in your export. A PST file can only contain email messages and 

their attachments. Attachments can only become part of the PST by 

including their parent emails instead.  Calendar appointments cannot be 

exported to a PST file, as it is not associated with an email.  However, 

contact information can be included for exporting to a PST.  Please note 

that these results will not display in the contact folder when open in 

Outlook.  Those results will be contained in a regular PST folder under the 

Mail section, not the Contact section. 

The Export to PST function allows you to automatically include the parent 

item of attachments being exported to a PST. You can choose to either 

include the top-level email parent or the direct email parent.  An example 

would be an attachment contained within an email message within another 

email message.  With the top-level parent selected all parent items of the 

attachment (both emails) would be included in the PST, one nested within 

the other.  The second option exports the nested email to the PST. You can 

also choose to simply skip non-email attachments. 

Note: Files in a folder source lack a parent email and therefore cannot be 

exported to a PST file, except for EML, EMLX and MSG files. 

How to export attached emails? 

The last setting controls what happens with emails that are selected for 

export and that also happen to be attachments. These are typically 

forwarded messages. Such emails can technically be exported to a PST 

without any restrictions, but the investigation policy may require that the 

parent email is exported instead, to completely preserve the context in 

which this email was found. That can be done by choosing the Replace with 

its top-level parent email option. Alternatively, use the Export attached 

email option to export the attached email directly to the PST. 

15.2.4 Export to iBase and Analyst’s Notebook 
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Intella can export its results into a format that can easily be 

digested with i2’s Analyst’s Notebook and iBase products. All 

metadata of all items, all attachments and all email bodies can 

be imported into these tools, allowing rapid social network analysis and all 

other analytical abilities of these applications on email evidence data. 

Templates, import specifications and instructions are provided for Analyst’s 

Notebook and iBase. Please contact support@vound-software.com for more 

information. 

15.2.5 Export as a Load 

File 

Intella 1.5.2 introduced the ability to export 

selected items as a so-called “load file”, for 

use in legal review applications. Intella 1.5.3 

added support for Relativity DAT files and 

Ringtail MDB files to the already supported 

exports for Summation DII files and 

Concordance DAT files. 

This functionality is currently in beta and 

may change in future versions. 

Documentation on the configuration options 

will be added in a future version of this 

manual. 

15.2.6 Destination folder 

All produced files will be placed in the 

selected destination folder. 

Though Intella tries not to overwrite any files in the specified folder, we 

recommend specifying an empty folder to be sure. 

For every selected format type, a subfolder will be created that holds the 

files of that export type. All export reports will be placed in the top folder 

itself. 
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When exporting a number of sets to the same destination folder, the 

subfolders with produced files will be merged, but earlier produced files will 

not be overwritten. Each export run will have its own set of export reports. 

15.2.7 File numbering 

By default, exported files will be named using 

the original evidence file’s name or the subject 

of an email. Alternatively, you can choose to 

number the files using consecutive numbers. 

These options can also be combined: a number 

followed by the file name or subject. 

The following numbering options are available: 

 The number to start counting with. By default, exporting starts 

counting at 1. A typical reason to use a different number is when 

you want to combine the exported results with another set of 

already exported files. Numbers are always 8 digits long. 

 A prefix. Anything you type here will be added to the beginning of 

the filename. E.g. the prefix “export-” will result in the first email 

being named export-00000001.eml. 

 When items are being exported to PDF, whether the prefix and 

number should be mentioned in the footer of the PDF. 

The file numbering panel is only enabled when Original Format or PDF is 

selected. 

15.2.8 Creating a report 

You can indicate whether you want to 

create an export report for this export. 

The report can be formatted as a PDF, 

RTF, CSV and/or HTML file. 

For PDF, RTF and HTML reports you 

can also add a comment that will be 

displayed on the first page of the 

report. 
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Export reports link the original files to the exported files, by listing 

identifying information about the original item (e.g. source evidence file, 

MD5 hash) and linking to the exported file. Also the export report may 

contain information that is lost during export, such as the evidence file’s 

last modification date; like any copy, the export file has the date of export as 

its last modification date. 

Important:  If the export of a specific result resulted in errors, you will be notified 

with an error message in the application. You can find the error notifications at 

the end of the PDF and RTF report or in the last column of the CSV report. 

15.2.9 Export templates 

All configuration options set in the 

Export window or a sub-window like 

the Load File field chooser can be 

stored as a user-named template. 

Simply type in a name in the text field and click Save. Clicking the arrow in 

the text field opens a drop-down box that lists all stored templates. 

Selecting one immediately restores the state of the Export window to the 

one stored in the template. 

Export templates are stored in the following folder: 

 Windows Vista and Windows 7 
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C:\Users\<USERNAME>\AppData\Roaming\Vound\Intella

\ export-templates 

 

 Windows 2000, XP 

C:\Documents and Settings\<USERNAME>\Application 

Data\Intella\export-templates 

You can easily access this folder through the Help > Open Export 

Templates Folder menu item. 

Note that export templates are stored outside of the case data folder. This 

makes all templates automatically available across all cases on the same 

machine and user account. To use templates with other user accounts or on 

other machines, just copy the XML file named after the template to the 

export-templates folder on that account or machine. 

15.2.10 Skipped items 

The exporting progress user interface may report skipped items. These 

relate to the fact that not all items are inherently exportable to the chosen 

export format(s). Examples are: 

 A file inside an encrypted ZIP file may be known to Intella but it 

cannot be exported to Original Format. Exporting to PDF is 

possible though. 

 Only emails and contacts can be exported to a PST. When using the 

default settings, Intella will try to replace non-exportable items 

with their parent email. If there is no parent email, the item is 

skipped. 

 Folder results are always skipped. 

All skipped items are listed in the export report. 

15.3 Exporting to a CSV file 

You can export a results list to a comma separated value (CSV) file. A CSV 

file contains all information listed in the table. CSV files can be opened in a 

spreadsheet application such as Microsoft Excel and can be processed 
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through scripting, which opens up new analytical abilities. This 

functionality can also be used to generate MD5 lists. 

To export the table to a CSV file: 

1. Select the results in the table that you want to export to a CSV file. 

 

You can use the Select All option in the right-click menu to easily 

select all rows. 

 

2. Right click on the selected files and click “Export table as CSV…”. 

 

3. Marks the 

names of all 

columns that 

you want to 

include in the 

CSV file. 

 

4. Give the CSV 

file a name and 

select Export. 

The selected columns 

are stored so that the 

next time you bring up 

this dialog, the same 

columns will be selected. 

Should you frequently 

use different export 

settings, then you can save these as separate templates. Click the “New…” 

button to create a new template and enter a name. The new template will 

automatically be selected and any selection changes will be stored under 

that template name. Click the drop-down list to go back to the previous 

(default) template. The settings will now be restored to what they were 

before you created/selected the other template. 
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The contents of the Senders and Receivers columns are configurable to 

show either the contact name(s), the email address(es), or both. 

15.4 Exporting the social graph 

Intella can export the social graph of a collection of emails. This procedure 

creates a graph data file where all nodes where all nodes represent contacts 

and all edges represent the fact that mails have been sent between those 

two contacts. 

The edges are weighted, with the weight representing the number of mails 

that have been sent from one contact to another. The edges are directed to 

differentiate mails from A to B to those sent from B to A. 

The graph can be exported into the following formats: 

 A CSV file containing three columns: the sender, the receiver and 

the number of mails. 

 A GML (Graph Modeling Language) file containing that same 

information. 

 A GraphML file containing that same information. 

A CSV file can be very practical because it can be viewed and edited in 

spreadsheets and it is easy to write scripts that can process them. Be aware 

though that CSV is a very informal standard. Different tools may have 

different rules on how to encode special characters. Some tools that can 

process CSV graph files may require that the third column be removed. 

GML and GraphML are formats specifically designed for specifying graph 

structures. They can be processed in free tools such as Gephi and NodeXL 

as well as a number of commercial applications. As GraphML is based on 

XML, it offers the best solution for dealing with foreign character sets. 
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16 Previewing results 

 

 

 
  

Item summary: 

shows summary of 

important information 

related to the item. 

Previewer window: 

opens when item in 

table is double clicked. 

Search term hit: 

Location of search 

terms in the text. 

Item tabs:  

inspect an item’s contents, headers, 

properties, attachments, thumbnails, tree 

structure, extracted words, comments and 

performed user actions. 

Previewer 

actions: click 

Review, 

Explore or 
Produce to see 

Previewer 

actions 
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16.1 Overview of the Previewer 

When you double click an item, it will open in the Previewer. This 

component allows you to inspect, flag, and tag the item, to explore its 

relations with other items, and to export the item for later use. 

Below you will find the following information on the Previewer: 

 Explanation of the previewer window. 

 

 Reviewing an item. 

 

 Exploring an item’s relations. 

 

 Producing reports and tabs and exporting an item. 

16.2 Previewer window 

The previewer window has several parts: 

 The top part where you find three task panels: Review, Explore, 

and Produce. Every panel contains a strip of buttons that enable 

operations on the item in the previewer.  

 

 The middle part that 

lists important 

information related to 

the item shown in the 

previewer. 
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 The lower part where you will find tabs such as Contents, Headers, 

Raw Data, Properties, Attachments, Thumbnails, Tree (hierarchy 

structure), Comments and Performed User Actions. The available 

tabs will differ, depending on the type of item you selected.  

 

16.3 Reviewing 

The Review tab opens a strip of buttons that allow you to inspect, tag, and 

flag an item. With the Contents, Headers, Properties, and other tabs you 

can inspect different parts of the item. 

16.3.1 Navigation 

 Previous and Next buttons 

Go to the next or previous item in a list. Alternatively you can also 

use the keyboard shortcuts Alt+right-arrow to go to the next item, 

and Alt+left-arrow to go to the previous item. 

 

16.3.2 Tag 

 Tag button 

Opens the tag space where you can add new tags to your case and 

select a tag from a list of existing tags. 

 

 Quick tag buttons 

You can assign a tag to a quick tag button. Clicking the button tags 

the item and switches the previewer to the next untagged item in 
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the list. If no tag is pinned to a Quick tag button, it is randomly 

associated with one of the recently used tags by default. 

 

 Auto Advance button 

When this button is selected, clicking the quick tag buttons will 

switch the Previewer to the next item in the list. 

 

 Flagged 

Select this check box to flag the previewed item. You might want to 

flag an item for organizational reasons. For example, to keep track 

of the items that you have reviewed in the case. 

16.3.3 Matches 

 Red and green arrowed buttons 

With these buttons you can see where in the Contents and Headers 

tab search terms appear. When you click a button, the text will 

scroll to the place of next or previous search term. 

Tip: When search terms are present in the text of the item they are 

highlighted and the scroll bar of the Contents and Headers tab in the 

previewer will be marked with one or more orange lines. These lines indicate 

where you can find the search terms.  

16.3.4 The Contents tab and other tabs… 

 Contents 

This tab shows the body of an item. 

Note: If the item text is too long, it is truncated in the previewer for 

performance purposes. Click on the "Show full text" button to view the 

complete item text 

 

Note: When an item is encrypted, the Contents tab will show an image 

of a lock, to explain why no text could be shown. 
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 Headers 

This tab shows the complete header of the email item. This tab is 

only shown when you open an email item. 

Important:  Intella indexes all the email headers. You can search for 

words that are only part of the email headers if you select “Summary & 

Description” in the Search panel under Options (see Chapter 

10Keyword search). 

 Raw Data 

This tab is available for emails originating from PST files and for 

vCard files. In case of PST emails the low-level information 

obtained from the PST is listed here. This typically includes the 

transport headers (shown on the Headers tab) and the email body, 

but also a lot more. In case of vCard files the raw vCard contents is 

displayed here. All this information is also searched through when 

using a keyword search. This may lead to additional hits based on 

information in obscure areas that Intella does not process any 

further. 

 

 Metadata 

This tab shows metadata of items that does not fit elsewhere. 

Currently this is restricted to the raw content of a vCard file, as the 

Properties tab only shows selected properties only. 

 

 Properties 

Shows a list of properties connected to the item. For example: Size, 

Content Created, MIME Type, and Creator. 

The list of properties is different for each type of item. 

To copy all the text to the clipboard click Copy all. 

Tip: Hover over the question marks at the right hand side with your 

mouse and see a short definition of each property. 
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 Attachments 

Lists of all the attachments of the email item. This tab is only 

shown when you open an email item. 

Tip: When you double-click an attachment or select it and click View, it 

will be opened in new Previewer window. 

 Thumbnails 

Thumbnails of images (jpg, png, gif etc.) attached to an email item 

or embedded in a document such as the images in a Microsoft 

Word document. 

Select the checkbox below the image to flag a thumbnail. 

Tip:  When you double-click a thumbnail, the image will be opened in a 

new previewer window. 

 Tree 

Shows the location of the reviewed item in the item hierarchy 
(entire path from root to descendants), as well as all its child items.  

Tip:  The file names and subjects are clickable.  You can also right-click 

and choose to either select all above or select all below, or simply select 

items manually, to assign them to a tag.   

 Entries 

List of entries (items) found in an archive file such as a ZIP file or a 

RAR file. 

Tip: Tip: When you double-click an archive entry or select it and click 

View, it will be opened in new Previewer window. If the entry is a sub-

folder inside the archive, its content will be opened in the same 'Entries' 

tab. Double-click the '..' entry on the top of the list to return to the 

parent folder. 

 Comments 

This tab lists comments attached to the item opened in the 
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Previewer. Every comment is has an author name and time stamp, 

and the option to Edit or Delete the comment. 

 

 Words 

The Words tab lists all words/terms extracted from this item, 

together with the following information: 

- the search field the term belongs to: text, title, path, etc. 

- the frequency of the word in this document and document field. 

- the number of documents having this term in the same field. 

This list can be used to diagnose why a certain document is or is not 

returned by a certain query. 

The list can be exported as a CSV file by right-clicking anywhere in 

the table. Right-clicking also lets you evaluate a query with the 

right-clicked term. 

 

 Actions 

This tab shows the list of actions performed on an item. The 

action’s date and the user that triggered the action are shown in the 

list. Actions listed are:  

- Previewed- the item was opened in the previewer. 

- Opened - the item was opened in its native application. 

- Exported - the item was exported. 

 

 Preview 

This tab shows the item as if it was opened in its native application. 

The Preview tab is only shown when the format of the current item 

is supported and the Contents tab is not already showing it in its 

native form. The following file formats are supported: 

- Legacy MS Office formats (doc, xls, ppt) 

- New MS Office formats (docx, xlsx, pptx) 

- CSV and TSV files 

- WordPerfect 

- Open Office (Writer, Calc, Impress) 

- RTF 
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- HTML 

- PDF 

Note: To preview the MS Office formats, a local installation of MS Office 

2010, or a MS Office 2007 installation with the Save as PDF add-in, is 

required. 

16.4 Exploring 

To explore an item is to learn more about its relation to other items in the 

case. For example, an email might be part of a conversation that contains 

other emails that you would like to investigate. 

16.4.1 Search 

 Show Children 

Use this button to search for and display the children associated 

with the item being viewed in the previewer.  When selected, a 

search result with the associated children of the selected items will 

be available in the Cluster Map panel.  The label of the cluster will 

be “Children of [file name]” or “Children of [subject].” 

An example of a child item would be an attachment of an email.  

Intella views emails and attachments as separate items.  The 

attachment would be the child of the parent email. 

Child items can have child items of their own. Depending on the 

option that you select, the Show Children shows either only the 

directly nested children or all children in the tree. 

 

 Show Conversation 

Based on the subject of an email item, Intella can find items that 

are part of a conversation. Click the button Show Conversation to 

show all these items in the Cluster Map panel. 

The label of this cluster will be “Conv: [email subject].” The email 

subject is the email subject of the item in the previewer. 
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 Show duplicates 

When an item has duplicates in the case, click Show duplicates to 

display these duplicates in the Cluster Map.  The label of this 

cluster will be “Duplicates of [file name]” or “Duplicates of 

[subject]”. 

 

 Smart search 

Smart search lets one search for items that are similar to a selected 

item. It determines a set of keywords in the selected item that have 

a high information value. Typically these are keywords that occur 

often in the selected document but are not common words across 

the case, which makes them representative for the content of the 

selected document. Using the Smart Search dialog one can then 

find other documents that share these keywords and therefore have 

a good statistical chance of being related to the selected document. 

A slider is provided that the user can use to set a threshold: the 

lower the threshold, the more documents are returned but at the 

cost of less relevance to the set of keywords. 

Checkboxes are 

provided to 

control which 

item fields should 

be used when 

determining the 

set of keywords. 

This way one can 

restrict the search 

for similar items 

to e.g. the 

document or 

message body 

only. 
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16.4.2 Browse 

 Preview Parent 

Use this button to open the parent item in a previewer window. A 

parent item contains one or more items. Example: Pictures found 

in a Microsoft Word document are separate items in Intella. The 

Word document is the parent item for these pictures. The same is 

true for items found in archive file, such as a ZIP file: The archive 

file is the parent item for these items. 

 

 Preview Parent Mail 

Use this button to open the parent email item in a previewer 

window. A parent email item contains one or more items. Example: 

A picture attached to an email is a separate item in Intella. The 

email is the parent for the picture. 

16.5 Producing 

In the previewer you can export the item and produce two types of reports. 

16.5.1 Export 

 Export 

This button opens the “Export result as” dialog. Enter a name and 

location if you want to store the item. 

 

 Print Tab 

This button opens a print dialog that shows the contents of the 

selected tabs (Contents, Headers, Thumbnails, etc.) of the item. 

Click the print button on the lower right to print the item. 

 

 Print Report 

This button opens a print dialog that shows the contents of all tabs 

of the item. If the item has attachments you are asked if these 

should also be printed. Click the print button on the lower right to 
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print the item. 

 

16.5.2 External 

 Open in Application 

This button opens the item using the computer's default application 

(e.g. a PDF file would be opened with Adobe Acrobat Reader if that 

is the default PDF viewer on your computer). 

 

 Open Containing Folder 

This button is enabled for items that represent files in the file 

system and provides quick access to it. When clicked, Windows 

Explorer will open, show the file’s folder and select the file in the 

folder. 
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17 Audit trail 

Every case has an audit trail file that contains a list of all user actions. Every 

line in the file describes a user-initiated action. 

The audit trail file is CSV file that can be opened with Microsoft Excel or 

Open Office Calc. 

You will find the audit trail file in the “audits” folder. This is a subfolder in 

the case data folder. 
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18 Preferences 

To open the Preferences dialog, select the File > Preferences menu option. 

To apply changes of the settings, click the Apply button. To apply changes 

and close the dialog box, click the OK button. The Cancel button will close 

the dialog box and discard all unapplied changes. 

The specific settings per tab are explained below. 

18.1 General 
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The Display splash screen while loading a case option controls whether a 

splash screen will be displayed after you have selected a case in the Case 

Manager for opening in Intella. 

The Restore the queries that were shown last option lets the current 

queries being stored during shutdown, and restores them the next time the 

case is opened. 

The Backup section controls how case backups are handled. The three 

options control whether or not a backup of the case needs to be made when 

the case is closed, or whether this needs to be asked on every occasion. This 

setting is set for each case individually. The Backups folder is shared by all 

cases though. When a case is backed up, a copy of the entire case folder is 

made and placed in this folder. A previous backup is removed, if the backup 

has succeeded – note that this will have consequences for the disk space 

that needs to be available. The default location of this backup folder is next 

to the cases folder. We recommend changing this to a location that is 

located on a physical disk, so that disk malfunctions do not damage both 

the actual case and the backup. 

The Language selection option lets you select the display language used for 

Intella. The set of values in the list depends on which language profiles are 

detected in the “translations” subfolder, located in the folder where Intella 

is installed. 

Intella checks online whether new language profiles are available for the 

current Intella version and the currently used language. When this is the 

case, a message is displayed in the upper right corner of the main window. 

Clicking on that message will open a web browser and download the new 

language profile. The Browse… button in this panel can then be used to 

install the new profile. 

The Date format setting lets the user select how dates and times will be 

displayed.  The dropdown menu allows for various formats selected by 

country. This setting is not dependent on the display languages and allows 

for all generally used formats, regardless of which language profiles are 

available. 
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The Check for updates on start-up option lets Intella look online for new 

versions of the software during startup. This lookup will be done once in 

every 24 hours. New versions will be shown in the upper right corner of the 

application. A message will also be shown here when this option is turned 

off or when fetching the last version information has failed. 

18.2 Search 

The Enable Search History option allows 

you turn off the search history. The main 

use of this is when you do not wish these 

search terms to be recorded – be aware that 

they are still being added to the audit trail 

and may leave traces in the log file. This 

setting is also a workaround for character 

sets (e.g. Korean characters) that cannot be 

entered properly when the history 

functionality is active. 

The Show Children options allow you to 

specify what children are returned when 

you click on Show Children in the Previewer 

or in the search results popup menu.  You 

can specify the level by including only 

directly nested children (direct children only) or directly and indirectly 

nested children (all children).  When you select the Ask every time option, 

you will be prompted for the desired level every time you use Show 

Children.  

The Show Parents options allow you to specify the level of search by 

selecting top-level parents (all items that are at the root of the hierarchy) or 

direct parents of the item(s). When you select the Ask every time option, 

you will be prompted for the desired level every time you use Show Parents. 

Furthermore, you can set it to only consider the emails in the path. This will 

let all other items be ignored before determining what the top-level or 



Page 182| Intella™ User Manual | © 2012 Vound, LLC 

direct parent is. Finally, you can let all items that are already top-level items 

be added to the result as well. 

Finally, the Saved Searches options control whether restoring of a saved 

search should ask for confirmation when the current list of searches is not 

empty. This is to prevent accidentally removing valuable search results. 

18.3 Results 

The Opening results option controls what 

happens when a result is double-clicked: open it 

in Intella’s internal Previewer or in the native 

application registered with that file type. 

The Cluster Map options let you specify whether 

transitions on the Cluster Map should be 

animated and if so, how long that animation may 

take. You may want to disable animation if it 

causes performance problems on your system. 

Furthermore you can specify whether or not the 

Cluster Map should automatically be scaled when 

it does not fit inside the window. You can also 

change this option using the Cluster map toolbar 

button, or go to View > Cluster Map > Scale to fit 

window. 

The List View setting defines the number of items to be displayed on a 

single results page when the List View mode is used in the Details pane. 

The Thumbnails View setting controls which thumbnails are shown based 

on the size of the original image in kilobytes. Images that are below this 

threshold are filtered out. 
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18.4 Tagging 

When tagging items, the policy of your investigation may be that some 

related items should be tagged as well, e.g. tagging items in a mail as 

privileged may require that all other items in that same mail are also tagged 

as privileged. The settings in this tab can make that happen automatically. 

The three radio buttons specify how other items in the hierarchy need to be 

handled: 

 Only tag the selected item is self-explanatory. 

 Also tag all attached/nested items results 

in all attached or nested items being 

tagged with the same tag as well. This 

works recursively, i.e. all children in the 

hierarchy are tagged. 

 Also tag all other items nested in the same 

top-level item means that everything from 

the top-level mail down to the most deeply 

nested child gets the tag. 

In addition to these three settings, you can specify 

that all duplicates should also be tagged. When this 

setting is switched on, all items in the case with the 

same MD5 or message hash will inherit the tag. 

Furthermore, their children or siblings may also be 

tagged automatically, based on the setting 

described above. 

The upper part of the Tagging tab with the tagging inheritance options can 

also available by opened by clicking the Tag Preferences button when 

setting a new tag. This dialog will also let you override the settings for the 

tag currently being set. 

The Previewer setting controls the maximum number of quick tag buttons 

that is shown in the Previewer.  
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18.5 MS Outlook 

Click Validate to ensure that Intella can 

locate the Outlook program files on the 

system. This is necessary for the ability to 

export to PST files. The status is shown in 

the (non-editable) field. 

If validation fails, please consult your 

system administrator to make sure that MS 

Outlook is installed correctly. 

18.6 IBM Lotus 

Notes 

Click Validate to ensure that Intella can 

locate the Lotus Notes program files on the 

system. The status is shown in the (non-editable) 

field. 

If validation fails, click the Browse button, select 

the path to the Lotus Notes folder in the file 

chooser and click Apply. 

Tip: The default installation directories for Lotus 

Notes is 

 

C:\Program Files\IBM\Lotus\Notes 

 

or on 64-bit systems 

 

C:\Program Files 

(x86)\IBM\Lotus\Notes 
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19 Menu, mouse, and 

keyboard shortcuts 

19.1 Main Menu 

19.1.1 File 

 Preferences… 

Open the Preferences dialog (see Preferences) 

 

 Undo Actions… 

User can undo any actions listed in the Undo Actions Pane, 

including tags, flags, and comments. 

 

 Close Case 

Closes the current case and brings the user back to the Case 

Manager window. 

 

 Exit (Ctrl+Q) 

Exit the application 

19.1.2 Sources 

 Re-index (CTRL+R) 

Recreate all indexes from scratch (after user confirmation). 

 

 Add New... (Ctrl+N) 

Add a new source to be indexed by Intella. 

 

 Edit Sources... (Ctrl+E) 

Open the Edit sources dialog box. 

For a detailed explanation of the source operations, please see 
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chapter 9 Sources. 

 

 Edit Evidence Paths… 

Opens the Attach Evidence dialog. This dialog can be used to edit 

the paths of the evidence files used to create the case. These paths 

need to be set correctly when the case is re-indexed. 

 

 Exceptions report 

Lets the user choose a CSV file to which the exceptions report will 

be written. 

19.1.3 View 

 Cluster Map 

o Animate Changes 

Turn cluster map animation on or off 

(see also: Preferences) 

 

o Scale to Fit Window 

Turn cluster map size scaling on or off 

(see also: Preferences) 

 

 Details 

o Table 

Switch the Details panel view into Table Mode. 

 

o List 

Switch the Details panel view into List Mode. 

 

o Thumbnail 

Switch the Details panel view into Thumbnail Mode. 

 

o Timeline 

Switch the Details panel view into Timeline Mode. 
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 Preview Item… (CTRL+O) 

Lets the user open a specific numbered item. See the Item ID 

column in the Details table for these numbers. 

 

 Close All Previews (Ctrl+Shift+W) 

Closes all open preview windows 

 

 Full screen 

Toggle full-screen mode 

19.1.4 Export 

 Cluster Map... 

You can export current cluster map graph as a PNG image, HTML, 

or XML image map (to publish the map on a web page). In the 

wizard dialog, select desired export format and enter a file name. 

 

 Timeline 

Export the timeline as a PNG image. Choose a file name and folder 

in the dialog. 

 

 Terms 

Export all terms in the case. When the results table shows a list of 

results, exporting of the terms of these items is also possible. 

 

 Result... 

Export a single result to a desired location. 

 

 Result List… 

Opens the export dialog to let you export the currently selected 

results. 

19.1.5 Team 

 Set Work Folder… (TEAM Reviewer and TEAM Manager) 

Open the dialog to set the location (folder) where the Intella work 
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reports will be stored. Select a folder in the dialog and click Select 

folder.  The default TEAM work folder is C:\Users\USER\Desktop. 

 

 Set User Name… (TEAM Reviewer and TEAM Manager) 

Open the dialog to set the name of the person that is doing the 

investigation. This will be used in the work reports. Enter the name 

in the box and click OK. 

 

 Export Work Report… (Ctrl+W, TEAM Reviewer and TEAM 

Manager) 

Open the dialog to export an Intella work report file (.iwr 

extension) to the work folder. 

 

 Open CSV Exports… (TEAM Reviewer and TEAM Manager) 

Open the dialog to open CSV files that were created together with a 

work report. Select the CSV file and click Open.  

Note: The CSV file will be opened in the application that is linked to the CSV 

file type by your operating system. For example: MS Excel or OpenOffice 

Calc. 

 Import Work Report… (Ctrl+I, TEAM Manager only) 

Open the dialog to import an Intella work report. Select an Intella 

work report file (.iwr extension) and click Open. 

 

 Work Reports History… (TEAM Manager only) 

Open the dialog that shows the list of work reports that were 

imported to this case. Every entry in the list has the investigator 

name, the creation date of the Intella work report and the import 

date. 

 

To delete a selected work report from you case, click Remove Work 

Report contents in the Work Reports History dialog. You are asked 

to confirm since this operation cannot be undone. 
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19.1.6 Help 

 Help Topics (F1) 

 

 Forum 

Opens a web browser and directs it to the online Intella forum. 

 

 Dongle Manager 

A shortcut to the separate Dongle Manager application, used to 

inspect and update the contents of your Intella dongle. 

 

 Open Log Folder 

Opens the folder where Intella stores logging information. 

 

 Open Export Templates Folder 

Opens the folder where the user-defined export templates are 

stored.  These files are .xml files that can be shared and copied to 

other case folders. 

 

 About Intella 

Shows a dialog with three tabs. (1) The first tab contains the version 

number of Intella. (2) The second tab contains system information. 

(3) The third tab shows license information such as ID, type and 

restrictions. 

19.2 Mouse actions 

19.2.1 Table and thumbnail view 

 Click and drag 

Select multiple items 

 

 Ctrl+click 

Select/deselect items 
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 Double click on item 

Depending on the preferences, this opens the clicked item in 

Intella’s internal Previewer, the registered native application, or 

opens a dialog asking the user what to do. 

 

 Right click on item 

Opens the popup or context menu 

 

19.2.2 Timeline 

 Click on email 

Opens the email in the Previewer. 

 

 Double click on email 

Depending on the preferences, this opens the clicked item in 

Intella’s internal Previewer, the registered native application, or 

opens a dialog asking the user what to do. 

 

 Right click on email 

Opens the popup or context menu on that email. 

19.2.3 Cluster Map panel 

 Click on cluster or on label 

Select a cluster or a results set. 

 

 Click and drag 

Move cluster to reorganize map. 

 

 Right click on cluster, label or on the selections panel 

Opens the popup or context menu on that item. 
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19.3 Keyboard shortcuts 

19.3.1 Main window 

 Ctrl+R 

Re-index all sources 

 

 Ctrl+N 

Add new source 

 

 Ctrl+E 

Edit sources 

 

 Ctrl+O 

Open a specific numbered item 

 

 Ctrl+Q 

Exit the application 

 

 Ctrl+W 

Export work report (TEAM Manager and TEAM Reviewer) 

 

 Ctrl+I 

Import work report (TEAM Manager only) 

 

 Ctrl+Shift+W 

Closes all open preview windows 

 

 F1 

Open Intella help file (requires PDF-viewer, like Adobe Acrobat) 

 

 Spacebar (in thumbnail view) 

Flag selected item 

 



Page 192| Intella™ User Manual | © 2012 Vound, LLC 

 Ctrl+A 

Select all items or text 

19.3.2 Previewer window 

 Alt+Right Arrow 

Move to next item 

 

 Alt+Left Arrow 

Move to previous item 

 

 Ctrl+C 

Copy selected text 

 

 Ctrl+V 

Paste copied text 

 

 Ctrl+A 

Select all text 

 

 Ctrl+1, Ctrl+2, or Ctrl+3 

Tag an item with the tag assigned to button 1, 2 or, 3 in the 

previewer 
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20 Appendix I. HASP 

problem resolution 

20.1 Problem flowchart 
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20.2 Problems and solutions 

20.3 Installation problems 

20.3.1 HASP dongle drivers do not install 

Problem: You are not able to install the HL Key (dongle) drivers. 

Cause: Presence of older HASP HL key drivers installed on the machine 

Solution: Uninstall the older drivers. 

1. Click Start > Run or click the Windows key + R 

2. Enter  

C:\Program Files\Vound\Intella\bin\haspdinst.exe -kp 

purge and click OK.  

3. Wait for message that operation was 

successful.  

Caveat: These steps uninstall ALL other HASP drivers. 

Make sure you have no other HASP dongle that requires 

an older driver. Install the latest driver.  

20.3.2 HASP dongle not found 

Problem: The following message is triggered "HASP key not found 

(H0007)" 

Possible cause 1: The HASP dongle LED is not lit. The dongle is not 

connected or not properly connected to the USB port. 

Solution 

1. Disconnect, pause a few seconds, then reconnect. If the LED lights 

up, the application should be able to access the dongle. You may 

need to wait a few seconds for the dongle to be completely installed 

by the operating system.  

2. The required HASP HL key drivers are not installed. If you are 

running HASP SRM on a Windows platform, check for an entry for 
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HASP SRM in the Device Manager utility. If there is no entry, you 

must install the drivers.  

3. Check if the USB port is functioning correctly. Disconnect all other 

USB devices from their respective ports. Connect the HASP dongle 

to a different USB port. Try using a different USB device in the port 

from which the dongle was not accessible to test if the port is 

actually working.  

Possible cause 2: HASP License Manager Service is not running. 

Solution 

1. Check if the HASP License Manager Service is running by opening a 

Command Prompt (Start > All Programs > Accessories > Command 

Prompt)  

2. Enter: sc query hasplms 

3. Check the result. It should show like this... 

SERVICE_NAME: hasplms 

TYPE : 10 WIN32_OWN_PROCESS 

STATE : 4 RUNNING 

(STOPPABLE,NOT_PAUSABLE ,IGNORES_SHUTDOWN) 

WIN32_EXIT_CODE : 0 (0x0) 

SERVICE_EXIT_CODE : 0 (0x0) 

CHECKPOINT : 0x0 

WAIT_HINT : 0x0 

If you see RUNNING the hasplms is running. 

20.4 Hardware problems 

20.4.1 No dongle detected 

Problem: The computer does not detect the dongle. There are several 

potential causes, listed below. 

Cause 1:Conflict with other USB devices 

On occasion, the presence of other USB devices may cause problems with 

the HASP dongle.  
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Solution: Remove conflicting USB device/devices 

Cause 2:Incorrect device driver installed 

The HASP dongle may not function if an incorrect version driver is 

installed. 

Solution: see section Installation problems, HASP dongle drivers do not 

install. 

Cause 3:USB port is defective or HASP dongle not properly inserted 

Solution: Check that the LED light is lit on the dongle. If not, remove and 

reinsert. Wait for the operating system to detect the dongle. If it still does 

not light up, try another USB port or use a USB hub.  

Cause 4:Faulty dongle 

On rare occasions one may get a faulty dongle. The dongle neither lights 

nor is detected in Device Manager, even with proper driver installed. 

Request a replacement. 

20.5 Firewall & anti-virus 

problems 

20.5.1 Unable to access HASP SRM RunTime 

Environment (H0033) 

Problem:  

The error message: "Unable to access HASP SRM RunTime Environment 

(H0033)" might be caused by too restrictive firewall settings. 

Possible causes: 

 C:\WINDOWS\system32\hasplms.exe is blocked by firewall or 

antivirus application. 

 Port 1947 is blocked by a firewall application. 

 HASP License Manager Service is stopped.  

Preliminary test: 
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1. Disable all antivirus and firewall applications. Note that some 

applications such as Norton, McAfee, and AVG have both antivirus 

and firewall settings that may need to be individually disabled. 

2. If the HASP License Manager Control Center does not appear in 

the browser at http://localhost:1947 then we know that the 

anti-virus or firewall application will have to be configured. 

3. If the Control Center still does not appear, check for other firewall 

or antivirus applications that may be running and disable them or 

turn them off.  

Solution:  

1. Add C:\WINDOWS\system32\hasplms.exe in the Exception list 

of the antivirus and firewall application 

2. Add port 1947 to the Exception list  

3. Restart the HASP License Manager Service 

(Control Panel > Administrative Tools > 

Services)  

An example of a firewall exception is shown in the 

image on the right. 

Important: You must perform an installation “Reinstall” 

of Intella as the antivirus software may have blocked 

components during the first install.  

 

 

 

 

The following information is adapted from the SafeNet Sentinel HASP 

knowledgebase. 

Message: "Unable to access HASP SRM RunTime Environment (H0033)"  



Page 198| Intella™ User Manual | © 2012 Vound, LLC 

Problem: This error means that there is a communication error between 

the program and the local license manager. This error can be triggered by a 

number of causes, including (1) improper installation of the HASP RTE 

software, (2) personal firewall software blocking communication with the 

HASP LMS service, or (3) other software using the same port that the HASP 

License Manager uses (i.e. port 1947). 

Solution: To troubleshooting the error follow the steps below until the 

cause for the error is found: 

1. Open a web browser and connect to http://localhost:1947. 

This is the HASP SRM Admin Control Center. If it's possible to 

connect to this page, then the HASP SRM Runtime is installed 

properly. The problem lies elsewhere and you can disregard the rest 

of this document.  

 

If you get a message Page cannot be displayed then it's possible 

that HASP SRM Runtime is not installed (go to step 2) or blocked 

(go to step 3 and 4). 

 

2. Go to Start > Run, enter services.msc and click OK. 

 

The list is alphabetical. Search for HASP License Manager in the 

table and then check if its status is “Started”  

 

If this entry is not listed, then the HASP SRM Runtime is not 

installed. Please reinstall it. 

 

If the status is not “Started” check the event log for entries relating 

to the HASP License Manager service that will give an error 

message and further diagnostic information. 

 

3. Check your personal firewall software. There are many types of 

personal firewall software including Norton Internet Security (the 

Firewall is one component of this software), ZoneAlarm and others.  
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By default most personal firewall software will request permission 

to allow access for the HASP License Manager the first time it is 

run. If access is allowed there should be no problems.  

 

If access is denied you will encounter communication problems. To 

resolve such problems either disable the firewall completely (Note: 

this option has risks. Please contact your firewall vendor for 

details) or create a rule or exception in the firewall to allow the 

HASP License Manager communication. If there is an option to 

create a rule/exception based on a port number, allow port 1947. 

 

As there are many personal firewall products on the market it is not 

possible to list all the ways to configure each piece of software here. 

Please contact your firewall vendor for details on how to create 

exceptions or rules as detailed above.  

 

4. Check that there aren't any applications that use HASP registered 

port (Port 1947). If you find such a program, disable it and run the 

HASP application again. 

20.6 Normal operation 

Dongle installation 

Intella is shipped with the latest SafeNet HASP dongles. 

Intella is packaged with the SafeNet HASP RTE installer. 

When correctly installed, the Windows  

Device Manager reports three items in the 

“Universal Serial Bus controllers” section:  

 SafeNet HASP HL Key 

 SafeNet HASP Key 

 SafeNet USB Key.  

When incorrectly or incompletely installed, 

warning icons appear on the device.  
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HASP License Manager Service 

The HASP installer includes the HASP License Manager application that 

runs as a system service: 

C:\WINDOWS\system32\hasplms.exe  

The HASP License Manager Service hasplms.exe must be running to 

allow Intella to open. When this application is running you should be able 

to load the HASP License Manager Admin Control Center by entering 

http://localhost:1947 in an internet browser. 

 

HASP SL is the trial version 

license. 

HASP HL will only show when 

the dongle is plugged in.  

 

Windows system services 

A good indication that the 

License Manager Service is 

running properly, is that the 

entry is flagged as “Started” 

in the table of Windows 

system services: 



Page 201| Intella™ User Manual | © 2012 Vound, LLC 

20.7 Installation flowchart 

 

 

 


